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Copyright Information 

© 1995 – 2008 Xara Group Ltd 

1st edition Xara Xtreme 4 release notes, March 2008. 

 

The contents of these notes and the related Xara Xtreme software are the 

property of Xara Group Ltd and are copyrighted. Any reproduction in whole or 

in part is strictly prohibited. 

 

 

Trademarks 

Xara is a trademark of Xara Group Ltd 

Microsoft, Windows, Windows Vista, Excel, Outlook and PowerPoint are either 

trademarks or registered trademarks of Microsoft Corporation in the United 

States and/or other countries.  Adobe, Photoshop and Illustrator are either 

registered trademarks or trademarks of Adobe Systems Incorporated in the 

United States and/or other countries. MAGIX is a registered trademark of 

MAGIX AG. 

 

Xara Xtreme uses the ImageMagick library Copyright 1999-2007 ImageMagick 

Studio LLC www.imagemagick.org. A copy of the ImageMagick license is included 

in ImageMagick.txt in the HelpAndSupport folder of your Xara Xtreme 

installation. 

 

 

http://www.imagemagick.org/
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The Text Tool & Font Handling 

The Font Menu  
Selecting the dropdown Font menu displays a list of all the fonts installed on your 

computer, sorted alphabetically. The Font menu displays each entry in the font 

itself, so you can get an idea of the appearance of the font. Where there is a 

collection of bold and / or italic variants, these are shown in the sub-menu.  

 

The top section, above the rule off, shows the fonts used in the current 

document. 

 

 
 

 

Live Font Preview 
If you hold the mouse pointer over any entry in the Font menu for a fraction of a 

second, the selected text in the document will be updated to preview this font. 

This is not a permanent change until you actually click on the required font. 

Moving the mouse pointer over the menu will revert back to the initial font until 

you pause over another entry.  

 

If you hold the Shift key down while traversing the Font menu, then the font 

selection is updated instantly, with no pause required. This is great for very 

rapidly previewing large numbers of fonts. 
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Live Font Size Preview 
 

 
 

Next to the font size menu is a small pop-up slider control, like that used 

elsewhere in Xara Xtreme. This provides a direct, live font size control, and will 

adjust the font size of the selected text in real-time as you drag the slider. 

 

As with the pop-up sliders used elsewhere this can be used in two ways. Click-

release on the arrow and the pop-up will appear and stay on screen. You can 

now drag the slider, or use the mouse scroll wheel over the control to rapidly 

adjust the values. So, in this case, this provides a fast way of adjusting the point 

size using the mouse wheel and seeing the results directly on the page of you 

document as you do this. The alternative method of using pop-up sliders is to 

click-drag-release on the button and slider. This is a slightly more direct way of 

adjusting the control (requires less clicks). 

 

Instant Font Menu Navigation  
While the Font menu is displayed you can type the initial characters of the font 

name, and the menu will be scrolled to that section of the list e.g. if you type 'ver' 

it will instantly scroll and locate the Verdana font. 

  

Bold, Italic & Synthesized Fonts  
Previous releases of Xara Xtreme allowed what are called 'synthesized fonts' 

which were artificially created bold or italic variants, where there was no bold or 

italic version provided.  Apart from being a very poor substitute for a 

professional designed bold or italic font, this was incompatible with and not 

supported by important document standards such as PostScript and PDF. 

Therefore support for synthesized fonts has been removed from this release of 

Xara Xtreme. 

 

However you can easily emulate the same effect. To embolden a font, just give it 

a small line width and apply a line color. To slant a font, use the skew / slant 

feature of the Selector tool. 

 

Repelling Text Objects 
You can make any object in Xara Xtreme repel text so that text underneath it 
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automatically flows around the object, instead of appearing on top of it. This 

makes it easy to lay out pages containing long passages of text combined with 

photos and graphics. Once you've set them to repel, you can adjust the positions 

of your graphics and photos and the text will automatically adjust and reflow 

around them. 

 

Making an Object Repel 

To make an object repel text, select the "Repel text under..." option in the 

Arrange menu to bring up the repelling properties dialog. Or right click on the 

object and select the same option in the right-click menu. 

 

 
 

If desired, set a repel margin for the object. This determines the size of the 

margin between the edges of the object and the text that it repels. To close the 

dialog and turn on the repel text option click on "Repel". 

 

To turn off repelling simply bring up the repelling properties dialog for the object 

and click on "Don't repel". Note that repelling text objects only repel text that is 

underneath the objects, not any text that is on top. 

 

Note that single lines of text do not respond to repelling objects, only text areas 

and text columns. 

 

Text Underlining 
 

 

Click the Underline button on the InfoBar to apply an underline to the selected 

text. The underline color and size is automatically derived from the text color 

and size. 

 

Underlining Web Links 
When you add a Web Address URL to some text you have the option to 

automatically underline all links. This is a check box option on the Web Address 
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dialog (Ctrl+Shift+W). If you select this, all linked text throughout the document 

is underlined, and the underline command does not affect this. 

 

If you apply a URL to a group that contains some text, then the text will not be 

underlined. 
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Multi-page Documents 

Introduction  
Xara Xtreme supports multi-page documents to make DTP projects simple. 

 

You can easily create documents that are compromised of many pages, for 

example newsletters, PDF eBooks, brochures and small magazines. You can then 

easily keep track of all pages in the document, and easily move content from 

page to page.  

 

 
 

Xtreme features such as the Color Gallery, Bitmap Gallery and Name Gallery 

can also be better and more efficiently used. For example, if you have one image 

(perhaps a company logo) you can use it across multiple pages in a document yet 

Xara Xtreme will store just one original—allowing for greatly smaller file sizes. 

 

Throughout this chapter we will refer to ―pages‖ for clarity in instructions, but 

all features and settings apply to both single pages and double page spreads 

(unless stated otherwise) and you can easily change between the two types 

(described in the Double Page Spreads in Multi-page Documents section on the 

next page). 
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Double page spreads in multi-page documents 
Your illustration may run across two facing pages. This is called a double page 

spread. 

 

 
                              

 

You can have single pages or double page spreads in your multi-page document, 

as illustrated above, but only one or the other within a document. 

 

To switch between single or double page spreads, choose File > Page Options, 

and then check or uncheck the Double Page Spread option. 

 

If you change from a double page spread to single pages in an existing document, 

your spreads will be split into single pages.  Similarly, converting to a double page 

spread will cause the pages in your document to be ‗paired up‘ into spreads. 

 

 
The result of converting a double page spread document 

to individual pages, and then back again. 

 

Single 

page 

Double page 

spread 
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Note: it is possible for objects to overlap the pages of a spread (i.e. on pages 1 

and 2 in the illustration above) but not over separate pages or spreads (i.e. 1 and 

3; if you did want to do this, you would need to copy the object from page1 and 

paste it on to page 3 so that it appears there as well). 

The current page 
If you click a page in a multi-page document it will become the current page. The 

current page is relevant when inserting, duplicating or moving pages as described 

in the following sections. 

 

The current page in the document is shown by indicators on the page‘s corners: 

 

 
 

Inserting pages into your document 
 

New page 

To insert a new blank page after the current page: 

 Click the New Page button. 

 Or choose Edit > Pages > New Page. 

 

 
 

The new page will be the same as the original page including its size, orientation 

and any guidelines. But it will be blank; no page content is copied. 
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Duplicate a page 

To create a copy of the current page after the current page: 

 Choose Edit > Pages > Duplicate Page. 

 

 

The new page will be the same as the original page, including its size and orientation, 

and will include all its content so that you can use it as a template for new content. 

 

 

Moving pages within the document 
If you wish to move a page‘s location within the document page order you can 

do so. 

 

To move the current page: 

 Choose Edit > Pages > Move Page/Double Page Spread Up to swap the 

current page with the one previous to it. 

 Choose Edit > Pages > Move Page/Double Page Spread Down to swap 

the current page with the one after it. 

 

These menu options will be grayed out of if you are on the first or the last page 

of the document respectively. 
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Removing pages from your document 
To delete the current page from your document select Edit > Pages > Delete 

Current Page. The current page and all its content will be deleted. In the case of 

a spread the entire spread will be deleted along with its content. 

 

Navigating between pages 
As well as the usual methods of moving through your document (such as 

scrollbars and the mouse wheel) there are also some other ways to navigate the 

pages: 

 

 Page Up. Moves up the document. The amount moved depends on 

your zoom level. The further you are zoomed out the bigger the move. 

 Ctrl+Page Up. Go to and center on the previous page. 

 Page Down. Moves down the document. The amount moved depends 

on your zoom level. The further you are zoomed out the bigger the 

move. 

 Ctrl+Page Down. Go to and center on the next page. 

 Or click the up or down arrow on the status line: 

 
 

The status line is also useful for knowing what page(s) you are currently viewing. 

 

Note: all of these movements are relative to the page you are viewing, not the 

current page. 

 

Printing and exporting multi-page documents 
There are settings which relate to printing and exporting multi-page documents. 

 

Printing pages 

To print your document choose File > Print (shortcut Ctrl+P). 

 

For more 

information on 

printing see 

chapter 22 of the 

main Xtreme 

manual. 



 

 

 

12 

 

Release Notes: Xara Xtreme 4 

 
 

 

In the print dialog you can choose which pages to print. The options are: 

 

 All Pages. Prints every page of the document. 

 Current Page(s). Prints the selected page or spread. 

 Page Range: allows you specific control over which pages you wish to 

print. You can type specific pages numbers, separated by commas, or 

page ranges by typing two numbers with a hyphen in between them. 

 

Page range examples: 

 2 will print just page 2. 

 1,3,5-7 will print pages 1, 3, 5, 6 and 7. 

 2,3,6-8,11-12 will print pages 2,3,6,7, 8,11 and 12. 

 

The Options section of the dialog will indicate if your page range is OK or 

invalid. 

 

Printing/exporting spreads 

When you print your document, or export it as a PDF, double page spreads will 

be printed/exported as separate pages. You can, however, tell Xara Xtreme to 

print and export spreads as one page. This is particularly useful if you wish to put 

a printed brochure on to a website and want to keep spreads intact for easy 

reading. 

 

For more 

information on 

PDF export see 

Chapter 23: 

Importing and 

Exporting of the 

main manual 
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To keep spreads intact choose File > Page Options, and then select Print/Export 

Whole Spread. Conversely, select Print/Export Individual Pages to print and 

export each page of every spread separately (this is the default option). 
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The 3D Extrude Tool 

 
 
The Extrude tool brings a fast and easy way of turning 2D drawn shapes and text 

into high quality 3D 'extruded' versions, with colored light illumination and very 

high quality shading. It is based on the technology used in the Xara3D stand-

alone program. 

 

On-screen dragging allows real-time 3D object rotation, dragging of the extrude 

depth, and adjusting of three lights in 3D space around the object. 

 
 

The InfoBar provides control over the bevel type drawn down the extruded 

length. You can chose from more than 25 different types of  

bevel.
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Extruding a shape 
To turn a 2D shape into a 3D extruded object, go into the extrude tool on the 

main toolbar 

 

and simply click and drag on your object to rotate it in 3D space. Initially 

your extrusion is given a default extrusion depth. The face color of the 3D shape 

is determined by the fill color of the original shape and the color of the extrude 

(or side) by its line color. After creating an extrude in this way, move your 

mouse pointer around over the 3D object. You'll see that the mouse pointer 

changes as follows, to indicate what will happen if you click and drag at any 

point:- 

 

 This is shown when the mouse pointer is over the front or back face of 

the object. Clicking and dragging rotates the object in 3D space 

 

 This is shown when the mouse pointer is over the extrusion (the side) of 

the object. Clicking and dragging changes the depth of the extrusion. 

 

 This is shown when the mouse pointer is over the extrusion and the Ctrl 

key is held. Clicking and dragging changes the bevel size (see below). 

 

Extrude tool InfoBar 

 

 
You can adjust a 3D extruded object by manipulating it directly on the page as 

described above, or by selecting it and using the controls on the InfoBar of the 

Extrude tool. 
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Turning Extrudes On and Off 

 
Once a shape or other object has been extruded, there are only limited 

modifications that can be made to the original object with the extrusion in place. 

For example if you've extruded a shape, it's not possible to then edit that shape 

in the shape editor tool because it's no longer a simple 2D shape. However using 

this control you can temporarily turn the extrusion off, so that you can see and 

modify the underlying object using other tools, before turning the extrude on 

again. After making a modification, just click this button again and the last 

extrusion is re-applied to your modified 2D object, with all the same 3D 

attributes that it had when you turned off the extrude. 

 

Note that in some cases if you dramatically change the form of the object while 

the extrusion is turned off (such as changing it to a completely different type of 

object), the 3D extrude attributes you applied may not be preserved. In such 

cases you should be able to use Paste Attributes to copy the attributes from a 

copy of your original extrude before the modification. 

 

Extrusion depth 

The easiest way to adjust the depth of an extrusion is to simply click and drag on 

the side, as described above. However you can also use the slider on the left of 

the extrude tool InfoBar to adjust it. Make sure that "Extrude depth" is selected 

in the dropdown list to the left of the slider (this is the default setting) and then 

use the slider to adjust the extrude depth. The current extrude depth is shown 

in a numeric field to the right of the slider and you can also enter extrude depth 

values directly into that field to set an exact extrude depth. 

 

 

Bevel Type & Size 
The Bevel Type determines the profile of the extruded side of your 3D shape 

and of its edges and corners. By default it's set to Rounded which gives a flat side 

with rounded corners. The Bevel Type dropdown list contains a large selection 

of different bevel types you can choose from. You can adjust the size of the 

bevel using the slider to the right of the Bevel Type list. To the right of the bevel 

size slider is a numeric field showing the current bevel size and you can enter 

exact bevel sizes into this field. An alternative shortcut to adjust the bevel size is 

to drag on the side of the 3D object holding the Ctrl key (while in the Extrude 

tool). 
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Lights 
 

 
You can adjust the lighting of your shape in 3D space by turning on the lights. 

There are 3 lights, each of which can be given their own color and position in 3D 

space around the 3D shape. 

 

 
 
In this example the face color of the shape is set to white. But you can see that it 

appears green because there is a green light shining almost directly onto the 

front face of the shape. By adjusting the colors of the face and extrude and the 

positions and colors of the three lights, you can enhance the 3D effects in your 

design. Behind the object is a beige / orange colored light and another that is a 

purple color. Both lights cause reflections down the side, and changing the color 

or direction of the lights behind will change the reflected highlights. 

 

To move a light around the 3D object, simply drag on the light arrow. If you 

happen to drop a light so that it is behind the 3D object and therefore isn't 

selectable, you can retrieve it by using the left slider on the extrude InfoBar. 

Select one of the light angles from the dropdown list to the left of the slider (eg. 

Light 2 Angle 1) and then adjust the slider. The light moves around the 3D object 

in your design. The various Light Angle options in this dropdown list allow you 

to move any of the lights in any direction in 3D space to achieve the positions 

you want. However for most purposes you can achieve good results most easily 

by dragging the light arrows directly on the page. 

 

To change the colors of the lights, you can simply drag colors from the color bar 

and drop them directly onto the light arrows. To edit a light color with the color 

editor, double click on the light arrow you want to change and the color editor 

opens with that light color selected. You can now edit the light's color. With the 
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color editor open, as you click on the different light arrows, extrude face and 

extrude sides, the color selected in the color editor dropdown list changes to 

match your selection, so you can quickly select the different colors on your 

extrude to modify them. 

 

Gloss / Matt 

  
 

Use this toggle button to make the surface of a 3D object more or less 

reflective. With the gloss option on, lights placed at the correct position behind 

the object will 'bounce off' the sides to good effect. 

 
Mitred / Rounded Corners 

 
 

You can choose either mitred or rounded corners for your 3D object. Mitre 

gives square edges, while Round produces rounded edges. 

 

Textures & Photos 
When you extrude a photo the photo remains on the front face of your 3D 

object. Therefore you can produce impressive 3D photo effects in seconds by 

simply importing a photo and extruding it. 

 

 
 
This effect is created by extruding a photo, rotating it slightly, creating a copy 

reflected using the Selector tool, and the 3D angle adjusted to match. It's then 

given a graduated transparency to create the faded reflection. 
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You can use any photo or texture on the face of your extrude. Either import 

your image and extrude it as described above, or drag and drop an image onto 

the face of an existing extrude with the Shift key held down. This applies your 

photo or texture to the face of the extruded object. 

 

Extruding Text 
Extrude text the same way that you extrude any shape - just click and drag on 

the text while in the Extrude tool. As you would expect, doing this on more 

than a few words can be rather slow and is not recommended. 

 

Because text is usually black, unless you change the color the extruded result 

will also be entirely black, so making it difficult to see. So it's recommended that 

you change the color of the text before you extrude it (although you can change 

this after by just clicking on a color). 

 

As with other extruded objects, if you want to edit the text, just turn off the 

extrude using the button on the left of the Extrude InfoBar, edit the text, and 

then switch the extrude back on again with the same button. 

 

Copying 3D Extrude Attributes 

You can copy and paste the style of the 3D extrusion, from one 3D object to 

any other. This works the same way as for all Xara Xtreme attributes. Simply 

copy the source extruded object to the clipboard, and then select a new one and 

select Edit -> Paste Attributes.  Note this will only paste the 3D attributes onto 

another 3D extruded object. So you will have to extrude any shape first before 

pasting the 3D attributes. This will copy all the 3D attributes such as the extrude 

depth, light colors, bevel type as well as the face and outline colors. 

 

Putting Shadows Behind 

Using the Shadow tool you can enhance the 3D effect by placing a soft shadow 

behind the object. Simply go into the Shadow tool, and drag on the 3D object. 

 

 
 

The left example is using a Wall Shadow, the right is using a Floor Shadow. 
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Graduated Face Colors 
 

 
If you give an object a graduated color, or any complex fill color, this is 

transferred to the extruded 3D version as well. This can be used to give 

dramatic lighting effects, as in the above example. 
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HTML Export - Website Creation 

You can easily create multi-page websites with full WYSIWYG (what you see is 

what you get) using the HTML export option.  The HTML generated uses CSS 

absolute positioning to try to make the web page look as much as possible like 

the design as displayed in Xtreme. And by using layers it's easy to make pages 

respond to the mouse pointer moving over them (e.g. mouse-over buttons) and 

even to add pop-ups. 

 

The advantage of using Xtreme to create websites is that you get almost 

complete freedom to position items anywhere, to include as many graphics as 

you like, even semi-transparent graphics, wherever you like on the page, text 

wherever you like, even rotated text, or text repelled around objects. These are 

difficult or impossible with normal web authoring tools.  Xtreme does all the 

necessary work to create the HTML and JavaScript to create a website that 

looks as close as possible to your page layout. 

 

To create a multi-page website, just create a multi-page Xara Xtreme document. 

There are pre-designed HTML templates included in the package, and using the 

Xara Named Color system you can easily create and change the theme color of 

your whole website. 

 

Note: Xtreme does not FTP or upload your website to your web server. You still have 

to manage this aspect yourself using an appropriate FTP or upload utility 

 

 
Caption: An example page in Xara Xtreme and the exported HTML version in a web 

browser.  

 



 

 

 

22 

 

Release Notes: Xara Xtreme 4 

Exporting HTML  
To export your design as HTML, choose Export from the File menu and find 

"Website (HTML)" in the list of export types. Choose a name for your website, 

with a .htm extension. A folder is created alongside the HTML file and this holds 

all the images for your web site. For example if you export your page as 

mySite.htm, a folder mySite.htm_files alongside it will contain all the images for 

the site. 

 

There are a few rules that you need to understand before creating your website 

pages in Xara Xtreme. 

 

Group Your Graphics  
Each separate graphic element on the page will be exported as a separate PNG 

file, and layered exactly as in Xara Xtreme.  Unusually this means you can even 

place semi-transparent graphics over text or other graphic elements, as these 

are exported as semi-transparent PNG files. 

 

However to reduce the size and complexity, we recommend you group separate 

elements together, as each group is exported into the HTML as a single image. 

You can therefore control the number of separate images that need to be 

exported to make up the web page. Designs containing hundreds or thousands 

of objects should be well grouped to reduce the number of separate image files. 

However a group can have only a single URL web address link (see below) 

applied to it to make it clickable. As a result each clickable button on a web page 

should made a separate group. 

 

Text  
Any text in the design that is not grouped or part of a more complex object type 

is exported as HTML text into the HTML page. This means that the browser 

used to view the page will be responsible for displaying the text and that search 

engines can find and scan your text. Because different web browsers display text 

slightly differently this means, in some cases, text may not be positioned exactly 

as it appears in Xtreme. We recommend testing your web pages is different 

browsers. 

 

It's important to use only standard fonts that are common to all web browsers, 

or otherwise people viewing the pages will see a different font to that used in the 

original design.  The following fonts are safe to use, and will be displayed 

correctly in the vast majority of web browsers on both Windows and the Mac. 

Arial 

Arial Black 

Comic Sans MS 
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Courier New 

Georgia 

Impact 

Lucinda Console 

Lucinda Sans Unicode 

Palatino Linotype 

Tahoma 

Times New Roman 

Trebuchet MS 

Verdana 

 

You can arrange for text to be exported as an image, instead of as HTML text, 

by simply grouping it. So for example if you want a large heading in, say, 

Calligraphic Regular font, just select the text and press Ctrl+G to make it a 

group. This will now be exported as a PNG so it will look exactly as you see on 

screen. 

Repel Text Around Objects 
Perhaps unusually (because HTML does not directly support this feature) you 

can use the text repel feature to repel text around objects and shapes, and this 

will export correctly. However HTML restrictions prevent this working with 

justified text.  The same applies for tabs in text - this is only accurate if using left 

aligned text. 

 

Rotated text is always exported as a graphic because browsers can't normally 

display text at an angle, and when they do, it's usually very poor quality. 

 

Line Spacing & Point Sizes 

You'll find that certain font sizes have more accurate page positioning than 

others. This is due to the fact that text in the browser is not always displayed at 

exactly the correct size. Sometimes the browser will round down the text size, 

meaning that lines of text in the browser appear slightly shorter than in Xara 

Xtreme. Most times it rounds up, resulting in the lines appearing slighter longer 

in the browser than they do in Xara Xtreme. 

 

The most reliable way to control text size, that works best across different 

browsers on different computers, is to specify the text in pixel units. You can do 

this by appending 'pix' to the size e.g. by entering '14pix' in the font size field. It's 

not recommended to use fractional pixel values - although Xara will correctly 

display such text, most browsers do not. So a value of 10.9pix will look quite a 

lot larger in Xtreme than in the browser, that will round this down to 10pix. 

 

TIP: Xtreme usually displays text in points, so even if you enter a size such as 10pix, it 

will display that as 7.5pt, but it will get exported as pixel sizes. 
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You can set an option to always display text sizes in pixels, rather than points, 

and for creating web pages this may be preferable. To do this open the Options 

dialog from the Utilities menu, select the Units tab, and then select 'pixels' from 

the Font units drop down list. 

 

For the advanced user, the rules used by Xara Xtreme to obtain the most 

accurate text size, across the widest range of browsers are: 

    - Font sizes entered that are whole point sizes, e.g. 10pt, are output as points 

in the HTML 

    - All other sizes, such as fractional point sizes, are converted to pixels in the 

HTML 

 

It should be noted that using points produces very different results when viewed 

on Macs compared to PCs (text is much smaller on the Mac). It's recommended 

to use pixel units to ensure greatest accuracy and compatibility across different 

browsers and computer types. 

 

Justified Text 

Due to restrictions in HTML it's not possible to always accurately display fully 

justified text, and you may find that the text flow is slightly different in the 

browser, and may even vary between different browsers. Left and center aligned 

text should be accurate and the line breaks and line spacing will be exactly as 

shown in your Xara Xtreme page. 

Web Page Backgrounds 
Any page background color or image in Xara Xtreme becomes the web page 

background. But unlike the background in Xara Xtreme, that extends only over 

the visible page area, on the web page it covers the entire visible web browser 

page area. To create a background that is an exact size, such as that of the visible 

page, draw a rectangle under all other graphics, typically on the background 

layer, and fill it with the required color or image. 

 

Setting the page background in Xara Xtreme is easy; 

 

 To set a background color, drag a color from the color line, hold Ctrl 

and drop onto the background. To create a custom color, create a 

Named color, and Ctrl-drag that onto the background. Then any edit of 

that Named color will be reflected in the background.  

 To set a background image, select it in the bitmap gallery and press the 

Background button. This image will tile, that is repeat, in the web 

browser. 
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Page Size  
The exported HTML is WYSIWYG, so that everything on the page, and the page 

size, is replicated exactly in the web browser. The default page size in Xara 

Xtreme (800 x 600 pixels) is a good typical size for a web page, but you can 

configure any page size you like using the Utilities -> Option menu, Page tab.  

Only items on the Xtreme page are exported, items on the pasteboard are not 

exported as part of the web page. 

 

Web Links  
To add a link to some text, object or group in a design, right click on it and 

select "Web address..." or use the shortcut Ctrl+Shift+W (W for Web 

Address). When applied to text this is displayed in the exported web page in 

blue with underline, as is the convention for links. If you want to override this so 

it doesn't display as blue underline, then convert the text to a graphic and use 

the mouseover interaction as described below. (Or, for the more advanced 

user, you can edit a css file that controls this - see below.) 

 

You can add links to individual words or any range of characters within a passage 

of text. Go into the Text tool, drag across the text to select the characters on 

which you want the link to appear. Then select Utilities, Web Address... (or 

press Ctrl+Shift+W) and enter the link URL. The link will appear only on the 

text that you selected. 

 

Linking to Other Pages in Your Website 

To link to other pages in your multi-page website use the URL Web Address 

short cut of '##2', or just '2' or '_2' replacing the 2 with the appropriate page 

number. 

 

Linking to Named Objects 

You can also use names that you've assigned to objects to link to pages in your 

site. This is useful when you are not sure what page number the object may 

eventually appear on.  To link using object names instead, apply a unique name to 

an object on the target page which you know will always be on that page (e.g. 

perhaps to the main photo of the page). Then wherever you want to link to that 

page, simply enter the object name as the URL using the Web Address dialog. So 

to link to a page containing a photo to which you've assigned the name 

"myHouse", enter the URL "myHouse" in the Web Address dialog. To find out 

more about naming objects refer to the Help. 

 

To add a name to an object, click the Name Tag icon on the Selector Tool 

InfoBar. 
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In the Web Address dialog you can select an option to always show linked text 

with underlines, which is also the common standard for linked text. 

 

To find out more about adding Web Addresses to objects, see the Web 

Address section below. 

 

Images & Photos 
By default photos in the design which were imported as JPEG images are 

exported as JPEG images for the web page. Images are re-sampled to be 96dpi 

(i.e. screen resolution), so even if you import a very high-res photo direct from 

your digital camera, and scale it down, the reported resolution in Xtreme may 

be hundreds of dpi, which is not appropriate for web page use (but it might be 

appropriate for printing).  Xtreme automatically creates an optimized JPEG file at 

the correct resolution. 

 

All other image types are exported as PNG files. 

 

Forcing an Image to be JPEG or PNG 

You can force any image in a design to be exported as a JPEG by assigning the 

name 'JPEG' to it.  To do this select the object and then click the 'name tag' icon 

on the Selector tool InfoBar and enter the name JPEG.  If you have already used 

this name it will alert you to this fact, but select the Apply button to apply the 

name. 

 

 
 

Sometimes you might have a JPEG photo that you have clipped or perhaps 

rotated and require that objects behind the photo show through. Or perhaps 

you've added some transparency to your photo and you have some text under 

the photo. In this case you can force the image to be exported as a PNG (only 

PNG graphics can do transparency). This is exactly the same process except you 

apply the name 'PNG' to the image. 

 

To find out more about naming objects refer to the Help section on Object 

Naming. 

 

Alt And Title Attributes 

You can easily add HTML 'Alt' and 'Title' attributes to images (these are often 

called Alt or Title tags). The Alt attribute is shown in web browsers in place of 
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the image, where the image cannot be displayed, for example on text-only 

browsers, or for assistive technology such as web page readers for the blind.  

The Title attribute is displayed when you mouse (hover) over an image in your 

browser, a bit like Windows Tooltip. 

 

To add such an attribute, use the Naming system and give the image, or group 

(remember groups are converted to images on export) a name in the format 

Alt=string or Title=string.  So for example adding a name: 

 Title=Copyright John Smith 

will add this attribute to the image which will be displayed as a pop-up when you 

mouseover the image in your browser. 

 

To add a name to any object just click the Label tag icon on the Selector Tool 

InfoBar. 

 

 

The Title attribute is also used by Google to help identify images when 

performing image searches. 

 

The Title attribute can also be added to URL (Web Address) links in the same 

way. Just add a name to the linked text in the form Title=string and when you 

mouseover the link, the browser will display a tooltip with the 'string'. This is a 

great way to show more information on short links. 

 
Multi-page Designs  
Each page of a multi-page Xtreme document is exported to a separate web page. 

There is no need to create separate .xar documents for each page, just use the 

Edit -> Pages menu to add new pages. 

 

In the exported HTML, second and subsequent pages are named with "_2", "_3", 

etc. appended to the HTML filenames. So if you export MySite.htm, you'll get 

files MySite.htm, MySite_2.htm, MySite_3.htm, etc. And all the images for the 

website will be placed in the folder MySite_files. 

 

You can link from one page to another by entering a URL which is the page 

number, optionally with ## prepended. So enter ##2 to link to page 2. This 

means the links between the pages are independent of the filename eventually 

used to export the pages. 
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Mouseover Interaction  
There are two types of mouseover effects that are possible. The first is a simple 

'rollover' effect where the graphic changes as your mouse pointer moves over a 

link. This is typically used for links and buttons where it helps to indicate active 

links by changing color, for example. 

 

The second method allows pop-ups whereby any text or graphic can be made to 

appear anywhere on the page when you mouseover an object. 

 

Rollover Buttons 

To make an object in a web page change when the mouse pointer is over it (e.g. 

a rollover button), place a modified copy of that object at the same position on a 

separate "MouseOver" layer in your document. Or to make it change when the 

mouse button is pressed, place it on a layer called "MouseDown". The object 

must have a web address assigned to it in order for these effects to work. The 

object can be a single shape or a group. 

 

Important: The graphic on the MouseOver has to be the exact same size as 

that on the base layer. If you make it larger, only the area covered by the original 

graphic will be updated.  If you want to make it larger, then create an invisible 

rectangle around the original link graphic. 

 

Important: The MouseOver layer must be above the layer with the buttons on, 

and should not have other layers in-between. 

 

Here's a step by step guide to making a group respond to the mouse pointer in 

an exported web page: 

 

1. Create the button graphic on your main layer. This should be exported 

as a graphic, so if it contains text remember to group it before 

exporting. If it's text on a button, group the whole thing, text and 

graphics together.  

2. Add a link to the item using the Web Address dialog (Ctrl+Shift+W). 

This could just be a page number of you own website such as ##2, or a 

name of a target object on another page, or a full http link to any 

external web address. 

3. Create a new layer called "MouseOver", which is in front of your main 

design layer(s).  

4. Copy the group that is to change when the mouse pointer is over it.  

5. Switch to the MouseOver layer and choose the menu Edit -> Paste in 

place, to paste the copy at exactly the same X,Y position as the 

original, but now on the MouseOver layer.  
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6. Modify the item on the MouseOver layer so it looks different to the 

original (e.g. change its color).  

 

If you have multiple rollover objects in your design, they can all use the same 

MouseOver layer as long as the objects are spaced sufficiently apart so that their 

bounding boxes don't overlap. This is because when you rollover an object, the 

rectangular area on the MouseOver layer underneath the object is revealed. If 

you encounter this problem, try using pop-ups instead. See below. 

 

Note that NavBars created by the NavBar tool are not compatible as they stand 

with HTML export. As described above mouseover buttons must be grouped, 

whereas the NavBar tool requires that the button background is not grouped 

with the button text. Also the NavBar tool creates bars with the MouseOver 

layer behind, instead of in front of, the layer holding the button mouse off state. 

Therefore it's recommended that when using HTML export, button bars are 

created as separate buttons as described above and as demonstrated in the 

"Website (HTML)" templates in the Clipart Gallery. 

 

Always make sure that the MouseOver layer is in front of the layer which 

contains the mouse off graphics. 

 

Pop-ups  
These are more flexible and powerful than simple rollover effects. You can make 

any graphic appear anywhere on the web page as you mouse over any object. 

And it's incredibly simple.  

 

All you do is add a Web Address link to any object on your main layer, but 

instead of a real Web Address just enter the name of the layer with your pop-up 

on.  As you move the mouse over the object the layer is displayed, hiding as you 

move off the object. 

 

For example, to make a photo change from black and white to full color when 

the mouse pointer is over it:- 

 

1. Position and size the original photo as required. Copy it to the 

clipboard  

2. Click the white color on the color line to make it a black & white photo 

3. Add a Web Address link to the photo by right clicking on it and 

choosing "Web address...". Set the URL field to the name of the layer 

you will create next. e.g. 'Photo1Popup'  

4. Create a new layer with this name e.g. 'Photo1Popup', in front of the 

layer containing the original photo. 

5. Paste the photo into the new layer from the clipboard. It can be 
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anywhere on the page, or use Edit -> Paste in place to place the 

copy exactly on top of the old one.  

 

Now when you export and mouseover the black and white copy, it should 

display the full color copy. 

 

You can have as many pop-ups as you like in your design, each on its own layer. 

But always make sure that the pop-up layer is in front of, not behind, the layer or 

layers which reference it. 

 

Combining Pop-ups and Links 

If you want a mouseover pop-up and for this pop-up to link to somewhere when 

you click, just give the original object a link to a new layer, and then on the new 

layer give the object a link to the required web page. 

Transparency 
You can use Xara Xtreme's transparency controls to create transparent, semi or 

graduated transparent graphics. These will be automatically get converted  to 

alpha channel (transparent to semi-transparent) PNG images, which work with 

all modern browsers, even when placed over other graphics and text objects.  If 

you make photos transparent then be aware that these are usually exported as 

JPG images, which does not support transparency. This is OK still if you only 

have graphics under the photo, as it will export the JPG with the correct 

graphics incorporated into the photo. But if you have text under the photo, this 

probably will not work well as the browser displays text in slightly different 

positions or sizes. In this case you can force the image to be output as a PNG 

image which will work correctly. To do this just give the photo a name 'PNG' 

using the 'create new name' icon on the Selector tool InfoBar. 

 

To force any image to be exported as a JPG, simply add a name JPEG to the 

object.   

 

if you're embedding Flash animations, these can also be transparent or semi-

transparent. 

 

Recommended Workflow 
It's highly recommended that you regularly preview the results in your web 

browser. You can do this just by double clicking the exported HTML file to open 

in your browser.  Once you've done this, you can export again, replacing the 

existing HTML and then just click the Refresh button (or F5) on your browser to 

see an updated version. So the usual cycle is:  

1. Export your design as HTML into your desired folder  
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2. Open this HTML in your browser  

3. Edit the Xtreme pages as required, and export as HTML again, replacing 

the existing file  

4. Refresh your browser.  

 

Repeat steps 3 and 4 as required. 

 

Advanced - CSS files 
For those that like to edit the HTML or CSS, either by hand or using a separate 

web authoring tool, when Xara Xtreme exports HTML it creates one HTML file 

for each page, and a folder where all the images are stored. It also creates a 

separate CSS stylesheet 'default.css' which is placed in the same folder as the 

images. The CSS file contains a few global CSS settings, such as the page 

background color, link color, visited link color, etc. for the whole site. However 

CSS data which is specific to a page (such as the position of each image on the 

page) is included inline in the page HTML and is not included in default.css.  

 

Although it's recommended that text links are underlined, as this is the best way 

for users to see where your links are, you can prevent the browser showing 

underlines on links by adding this line to the CSS file  

    a {text-decoration: none;}  

You can alter the color of text links, the mouse off, over (hover) and visited 

colors, by altering these lines in the default.css file  

    a[href] {color:#0000ff;} 

    a[href]:hover {color:#ff0000; cursor:pointer;} 

    a[href]:visited {color:#800080;}  

 

 

And replace the RGB color after the # with any hex RGB color of your choice. 

 

Note: This HTML export feature produces CSS based, and modern, standards 

compliant HTML. 

 

Web Address Dialog  
The Web Address dialog allows you to add web links (URLs) to text and other 

objects on the page. This feature is used by Flash, HTML or Image Map Export 

and for NavBar creation.  
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URL: In this field, enter the URL you want for the link. This URL can be a 

relative URL (e.g. '../file.htm') or an absolute URL (e.g. 'http://www.xara.com'). 

The URL can refer to any sort of file (e.g. 'file.gif', 'file.htm', 'file.jpg'). For some 

export types you can enter special names in the URL field, which are interpreted 

during export, such as pop-ups in HTML pages or clickTAGs in Flash. See the 

HTML export and Flash help for details. 

 

Correct URL automatically: Select this option to make sure your URL is 

correctly formatted. For example, if you enter "www.xara.com" it will correct it 

to "http://www.xara.com/". The URL is corrected when you click the Add or 

Change button. 

Target frame for URL: If you want the URL to be opened in a specific frame 

in the browser, type the name of the frame in this field. By default, the value in 

this field will be '_self'. This means that the URL in the URL field is opened in the 

same frame as the current document.  

 

The drop-down list of this combo box contains four frame names that cause the 

browser to open the target document in different ways: 

 _self: Open the target document in the current frame. This is the 

default and the best option to use if you are not sure which to use.  

 _parent: Open the target document in the parent window or frameset 

that contains this frame.  

 _top: Open the target document in the main browser window, 

replacing any existing frames.  

 _blank: Open the target document in a new browser window.  
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 default: Do not include a TARGET attribute in the image map entry for 

this object. This has the same effect as _self unless you have used a 

BASE TARGET= tag in the document.  

 

You can either select one of these options, or type in the name of another 

frame. 

 

Clickable area 

Important: This option only applies to Imagemap export and does nothing for 

HTML or Flash export 

For Imagemap export, these option buttons let you specify what area of the 

object must be clicked on to trigger the link. 

Object shape: The user must click inside the exact outline of the object to 

trigger the link. This option is only supported when exporting image maps, not 

with general HTML export or other export formats. In all other cases the 

rectangle surrounding the object is always used (see below). 

Rectangle surrounding object: The user can click anywhere in the rectangle 

surrounding the object (the bounding box) to trigger the link. 

 

Underline text links: You can choose to have text with links shown 

underlined in your Xara Xtreme document by selecting the 'Underline text links' 

checkbox. This does not necessarily mean that the linked text will be similarly 

underlined in all exported files, it depends on the export format that is used 

(some formats don't support links at all).  This change happens in the document 

immediately you change the check-box setting. 

 

Add/Change Button: Clicking the Add button sets the web address of the 

selected objects to the URL shown in the dialog box. If the object already has a 

web address assigned to it and it's been modified, this button is labeled Change. 

 

Remove Button: Clicking this button removes the web address from all the 

selected objects. 

 

Including Flash Files  
Xara Xtreme is a fine tool for creating high-quality compact Flash animations. 

Each Flash animation is treated as a separate Animation document, which when 

exported as a Flash file results in a .swf file that can be embedded in your 

website.  In order to combine these, or any .swf Flash file, into your HTML 

website document you need to first place the previously created .swf file inside 

the htm_files folder that is associated with your saved HTML file. 

 

Then you put a placeholder graphic on the page where you want this Flash to 

appear and give it a name (using the name tag icon on the Selector Infobar, as 
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described above) such as; 

Flash="filename.swf" 

where filename is obviously replaced with the name of your swf file that you 

have placed in the _files folder. 

 

The placeholder graphic can be any graphic object, such as a simple rectangle. 

The size of the placeholder will determine the size of the resultant Flash object 

on the page. 

 

Transparency and Flash: Any Flash embedded onto the page this way can be 

transparent. So any parts of the Flash animation that are transparent or semi-

transparent will work correctly over other parts of your web page. 

 

Advanced: There is a second way of embedding Flash objects that uses the 

open source SWFObject script. You can read more about this and the potential 

benefits of using this method here: http://code.google.com/p/swfobject. 

To use this method of Flash embedding just use the naming convention on the 

placeholder like this; 

SWFobject=‖filename.swf‖. 

 

You can place Flash objects on pop-up layers, but you have to use the Flash= 

method and not the SWFObject= method of embedding Flash for this. 

 

Web Browser Compatibility 
 The HTML and Javascript produced by Xara Xtreme is compatible with the vast 

majority of modern web browsers, including Internet Explorer version 5.5 

onwards, Firefox, Safari (for Mac, Windows and iPod) and Opera. The HTML is 

standards compliant XHTML. 

 

Mac Compatibility: It's important that your website looks good for everyone 

including Mac users. Apple have made their Safari web browser available as a 

free download for Windows users, and this behaves exactly as it does on the 

Mac, and so is a good way of checking Mac compatibility without needing a Mac.  

The Safari web browser displays text slightly differently than most Windows 

based browsers. (In fact it's more accurate than Windows, more like text in 

Xara Xtreme, but slightly more blurry than most Windows users are used to.) 

 

Summary  
To create the best, most compact and compatible websites:  

 Group graphics together where possible. Each group is exported as a 

separate graphics image, usually as a PNG  

 Use only text fonts that are web-safe. This list is given above.  

http://code.google.com/p/swfobject
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 If you want to use other fonts, group the text (even with itself) to force 

these to be created as a graphic. 

 For the most accurate text positioning and sizing use whole pixel font 

sizes. You can enter pix values in any field in Xtreme, e.g. just type 

'14pix' into the font size field.  

 Imported photos (JPEG or JPG file types) will be exported as JPG 

images at the correct resolution for the web browser. All other 

graphics are exported as PNG images with transparency as necessary.  

To force any image to be a JPG type give it a name of JPEG. To force a 

photo to be PNG give it the name PNG. 

 

For mouseover (rollover) buttons:  

 Create a layer called Mouseover, and place the highlighted buttons on 

this layer, exactly over the top of the original button graphic. Any 

graphic on the main layer that has a Web Address attached will 

automatically show (in the web browser) the contents of the 

mouseover layer as the mouse pointer is moved over it. 

Note: The mouse-over effect only updates the rectangular region of 

the original object. 

 

For pop-up or more advanced mouseover effects  

1. Place the objects you want to appear on as a pop-up or mouse-over 

effect on a new named layer. e.g. Popup1 

2. Attach a Web Address (Ctrl+Shift+W) to the object on the main layer, 

of the new layer e.g. Popup1 

Note: This pop-up layer can contain text or graphics and can be at any 

position on the page.  This layer is displayed as your mouse-over the 

original object, and is removed as you move the mouse-pointer away 

from the object. 
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Photo Handling 

This chapter is intended to completely replace the Bitmap Handling Chapter in the 

manual (except the Bitmap Tracer section) but it covers a much wider range of photo 

handling topics,  including the new Photo Documents and Photo Optimization option. 

 

Photos are an integral part of almost all creative work nowadays, from websites, 

to flyers, brochures, DTP work and more.  

   

Photo handling in Xara Xtreme is very different than you may be used to with 

other graphics programs. 

 

In Xara Xtreme you can color, crop, copy, blend, mask, feather (fade the edges 

of) photos as much as you like. Not only is this type of photo handling faster 

than in any other software*, it results in tiny files, perhaps 10 to 100 times 

smaller than the native files of other photo editing software. Being a fully object 

orientated vector program, Xtreme can do a whole lot more than typical photo 

editing tools, from creating DTP-like layouts, websites, combining photos with 

text or advanced vector illustration work. The object oriented heart of Xtreme 

ensures non-destructive, lossless editing and the 'edit anything at any time' 

approach that differs so fundamentally from photo editing tools. 

   

This chapter covers the basic principles of manipulating photos and bitmap 

images in Xara Xtreme. The operation of the Photo tool is covered in the 

separate Photo tool chapter.  

   
*Benchmarks based on photo compositions created with multiple hi-res JPG digital photos  

 

Photo Objects  
In Xara Xtreme photos (or bitmaps) are just another type of object on the page. 

You can drag and drop photos onto the page from your File Explorer, and then 

you can resize, rotate, copy and move them around just like any other object. 

Importantly you can adjust the transparency, even graduated transparency, 

feather edges and clip and cut shapes out of photos with ease. The transparency 

feature lets you blend, merge or create composite photos.  

   

Where you might have to use layers in other photo tools, every object in Xara 

Xtreme is on its own layer and, just as with any object on the page, you can 

move it forward to be in front, or backwards to be behind other objects. 
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Importing Photos  
Xara Xtreme supports a very wide range of photo or bitmap types including 

JPEG, PNG, TIFF and RAW digital camera images, as well as many more types. 

The term 'bitmap' is the general term encompassing all types, but 

interchangeable with the word 'photo'. 

 

The easiest way to open an image is to drag the photo or bitmap file from your 

Windows File Explorer onto the Xara Xtreme Window. Or you can Select the 

File -> Open or Import menu options. 

 

 
 

The photo is imported at the position you drop it.  See below for information 

about the size of imported images. 

 

Replacing Photos 
If you drag and drop a bitmap file over an existing photo it will replace that 

photo, but keep the same container or frame size. This makes it very easy to 

replace photos on templates. You can use the Fill tool to adjust the size, position 

and angle of the photo inside its outline.  This is not true for Photo Documents 

(see the Photo Document section), where dropping a photo on the page will 

always import it as a new document. 

 

When replacing a photo or bitmap this way, it is sized to best fit in the existing 
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picture outline. If you hold the Shift key when replacing a photo, the new one 

will fit into the same dimensions and rotation as the old photo. This is useful 

where you've manually adjusted the scale or rotation of a fill and then want to 

replace the image with another which has the same aspect ratio. If you hold Ctrl 

down when you drop, the photo will simply be added to the document and will 

not replace any existing image. 

 

Using Photos as Fills 
You can also use any bitmap as a fill style for any drawn shape. Simply drag the 

file over the shape (which can be from your file system, or from the Bitmap or 

Fill Galleries), and hold the Shift key down before you drop. This will replace the 

existing color fill with a bitmap, fitted to the object.  Again you can use the Fill 

tool to adjust the size, angle and position. 

 

Initial Photo Size  
When you import a JPEG it's initially placed on the page at 96dpi - this is the 

same as the default screen resolution, so that at 100% zoom this is a 1:1 display. 

In other words each pixel of the photo takes one pixel of screen so you're 

seeing the full resolution image when viewing at 100%.  However because most 

digital photos are very high resolution, this means you'll only see a small part of 

your photo, so initially Xara Xtreme will automatically alter the zoom scale to 

zoom out so you can see the whole image. This also means that a typical digital 

photo will be far, far larger than your page size (your screen is probably only 

about 1200 pixels across, and a typical digital photo is 3 or 4 times as wide, 

sometimes a lot more). 

   

To reduce the size, just drag a corner handle using the Selector tool, or enter a 

new width in the Selector tool InfoBar Width field. 

 

 
 

If you replace a photo using drag and drop, then the photo is sized to exactly fit 

the container, and this means its size and resolution will depend on the size of 

the container. 

 

Photo Resolution 
One fundamental difference between Xara Xtreme and other photo tools is that 

when you resize a photo it retains the full resolution. Scaling an image to be 
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smaller just increases the dpi or ppi (pixels per inch). In other words no pixels 

are lost, they are just made smaller. 

96ppi image on the left when scaled down to half size becomes twice the resolution, 

192ppi. 

 

The Status line shows the resolution of any selected image.  Retaining the full 

resolution is important because it means you can see all the detail when you 

zoom in, and that when printing the maximum resolution is sent to the printer. 

Also it means you can enlarge all or part of the image and Xara Xtreme retains 

the original maximum quality. 

Zero-memory Copies  
One of the most revolutionary differences between Xara Xtreme and other 

software is that when you copy any photo on the page, it doesn't really make a 

complete new copy of the original photo but instead just displays another 'view' 

of the original image.  Xara Xtreme's rendering engine is fast enough that it can 

display any number of copies of the same image 'on the fly' this way. This saves 

huge amounts of memory and dramatically reduces files sizes. 

 

This doesn't detract or limit what you can do with each copy, and they can be 

treated as completely separate independent copies. Each copy does not have to 

be identical. You can manipulate each as required, resizing, rotating, cropping. 

coloring, feathering, or applying a wide range of photo and transparency effects. 

All for no memory or file size increase.   
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This shows separate copies of the same image, each manipulated in a different 

way. Each retaining the full resolution of the original JPEG, as you can see from 

the right image. The memory (RAM and file size) is no more than the original 

JPEG size. 

 

Because they are the same image displayed at different sizes the resolution, that 

is the dpi or ppi, varies. In the above example the eye is 115dpi, (because the 

image has been enlarged) while the image on the left is over 1200dpi.  

 

Bitmap Gallery  
The Bitmap Gallery shows all the bitmaps or photos used in any document, along 

with information about its pixel size and file size. You can open it by clicking its 

icon on the top bar, or from within the Utilities -> Galleries menu, or press F11. 
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This shows the Bitmap Gallery for the above document, and shows the original 

JPEG image of the girl which is embedded into the native .xar file. As mentioned 

above, all copies of this image are displayed directly from the one master, so 

only the single image is shown and not all four variants that appear on the page. 

 

The following useful information is displayed about the original image:  

    • Filename of the original JPEG  

    • The file type, in this case a JPEG, and the file size, 1,006K 

        (This is the original size of the file, and also how much of the.xar file will be 

taken up by this image)  

    • The pixel dimensions of the original, the Megapixel size (in this case just 

under 2MP) 

    • The color depth, in this case '24 bit' which is sometimes called True Color. 

The Xara image is a 4 bit image    

    • The original resolution of the image, in these cases 96dpi . 

 

The Bitmap Gallery always contains a default bitmap, with the grey Xara image. 

This is used as the default bitmap for bitmap fills and in cases where other 

bitmaps are missing. It's useful to have as a placeholder as well. 

 

As with all galleries, you can drag the objects from the gallery onto the page to 

create a new copy. Or you can select an image in the gallery and click one of the 

buttons across the top. The following operations are commonly useful from the 

Bitmap Gallery: 
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Filling Shapes With a Bitmap 

Select the shape on the page, then select the bitmap in the gallery and click the 

Fill button. Alternatively drag the image from the Bitmap Gallery and drop it 

onto any shape while holding the Shift key.  You can adjust the size, angle etc in 

the Fill tool. 

 

Setting a Bitmap Transparency 

This is for the more advanced user. You can use any bitmap as a transparency 

mask on any filled shape or bitmap. The lightness of the bitmap affects how 

transparent the selected object is. The bitmap transparency size, rotation and 

tiling can be controlled from the Transparency tool InfoBar. 

 

Deleting Images From The Gallery 

When you delete a bitmap from the page, it remains in the Bitmap Gallery. Any 

unused bitmaps will be deleted from the file when saved and re-opened.  

However you can force the deletion of any bitmap by selecting it and pressing 

the Delete button. If the bitmap is used in the document, it will be replaced by 

the standard Xara bitmap. 

 

Setting The Page Background to a Bitmap 

Select the bitmap in the gallery and click the Background button. This will tile the 

image. When exporting the page as HTML, this image is tiled across the whole 

visible page background of the browser. 

 

Save 

Select the bitmap and clicking Save will save the original image. In the case of an 

embedded JPEG this will save the original JPEG file.  Other bitmap types are best 

saved as PNG bitmap type. 

 

Bitmap Properties 

The Properties button will display information about the selected bitmap in the 

gallery. It also provides a way to stop image smoothing when bitmaps are 

enlarged. Usually all bitmaps are smoothed when enlarged, or zoomed into, on 

screen. There is a check-box option in the Properties dialog to turn this feature 

off, so that individual pixels are visible when you zoom in. Note that this option 

only affects scaled up bitmaps. Note also that the Never smooth option in the 

View tab of the Options dialog overrides this check box. 

 

It also provides information about the Animation properties of the bitmap. This 

is only really applicable to animated GIF images 
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• GIF Animation: Delay (the time this frame is left on screen) 

Restore: The Animated GIF Restore setting sets what happens between 

each frame in an animated GIF. Nothing means no action is taken. Many 

browsers take this as meaning the same as the Leave As Is option. Leave 

As Is displays the frames one on top of another - this leaves many frames 

visible in a stack if some are transparent. Some browsers clear the 

animation before it loops again, some do not. Background restores the 

area covered by the graphic to the background color of the GIF (usually 

white). Restore Previous restores the area covered by the frame to 

what it was before the frame was displayed. This is interpreted by some 

browsers to mean that the frame should be cleared to the background 

before each frame is displayed and by others to mean that the frame 

should be shown on top of the previous frame. As browsers interpret 

these values in different ways, you may need to experiment to achieve the 

desired result. 

 

Embedded JPEG files  
JPEG files are hugely compressed from their original state, being up to 10 times 

smaller than the original uncompressed image.  In the above example the original 

uncompressed image requires more than 7 Mbytes of memory, but as the 

Bitmap Gallery shows this JPEG file is only 1Mbyte. A very significant saving. This 

is why JPEG images are the standard file type for digital photography and use on 

the web. 

  

When you drag and drop a JPEG file (or use the Open or Import menu options) 

the original JPEG is stored in the document, and this is what is saved in the .xar 

file when you save your document. 

 

It's important to understand how this differs from other graphics tools, both 

vector drawing software and photo editing programs. Other products will 

typically un-compress the image and store the un-compressed 'raw' image in 

memory and the native file when you save to disc.  What's more each copy you 

make is typically a complete copy of the original raw image, as mentioned above.  

Make four copies of your photo and save your file - it will be four times larger. In 

Xara Xtreme the file is no larger, no matter how many copies you make. 

  

So by embedding the original JPEG file instead of saving the un-compressed 

image, that's a file size saving of more than 7:1 compared to other graphics 

editors. The fact that there are four complete copies of the image means that in 

this particular case the memory used is more like 30 times less. So this 

represents a huge file size (and time) saving over other graphics tools.  
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This is easy to test. Import a JPEG into your favorite graphics editor, make four copies, perhaps change each 

one slightly, to be colored or blurred or rotated. Then save the native file and compare it against the 

original JPEG size, and the equivalent .xar file. A .xar native file is about the size of the original JPEG, no 

matter how many copies of the image are made. 

 

Extracting The Original JPEG  

Right click on any image in the Bitmap Gallery and select the Save menu option 

to save the original JPEG back to your file system. 

 

Lossless vs. Lossy  
Because everything Xara Xtreme does with your photos is based on the original 

image, which remains untouched embedded in your file, everything it does is 

lossless.  There is no lossy re-compression of images when saving the native .xar 

file. 

 

Of course you can save or export your image as a compressed JPEG file, at any 

required size, and in this case the image quality and detail will be reduced in a 

'destructive' manner. Destructive here means that the original data or detail 

cannot be recovered from a lower-resolution saved JPEG. Xara Xtreme is a 

non-destructive editor because the original photo data and detail is never lost, 

reduced or compressed in a lossy manner in the native .xar file.  

 

Blending & Merging Photos  
By making copies of photos on top of each other, and applying different effects 

to the copies, combined with Xara Xtreme's advanced transparency controls, 

you can easily create blended photo compositions. For example, to selectively 

blur parts of a photo takes a few seconds.  
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By placing the blurred copy with the 'hole' created by the transparency effect 

over the sharp original, the blended result shows the sharp face area through the 

'hole'.   

 

 
 

Creating copies of any object requires a single key press or click (drag with right 

mouse button). Blurring a photo takes a single drag on a blur slider of the Photo 

tool, applying a gradated transparency is just another click-drag in the 

transparency tool, and finally positioning the photos on top of each other takes a 

second. So the whole process takes a few clicks, drags and just a few seconds in 

Xara Xtreme. 

   

Of course you're not limited to blurring effects, you can adjust colors, brightness 

and contrast levels, or apply any of the wide range of Live Effects to create an 

infinite range of interesting or creative results.   

 

Photo Display Quality  
Xara Xtreme can display photos in one of three quality levels. The normal anti-

aliased setting will smooth the screen pixels so avoiding visible pixels or 'jaggies' 

along the edges. 

 

There is a lower quality setting that performs no anti-aliasing, thus showing the 

individual pixels. This can be useful when you're zoomed in and you need to 

clearly see the separate image pixels.  The downside is that images generally look 

poor when reduced or enlarged resulting in clearly visible pixelation and jaggy 

'staircase' edges, especially if you rotate the image. 

 

Finally there is a very high quality mode, that displays images using bicubic 

sampling. This displays images at the best quality, particularly for large hi-res 

images that are scaled down or zoomed out a lot. 

 

The View Quality slider on the top bar controls the display quality, and offers 
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five steps. The first two settings are only useful for vector graphics.  

  

 
 

There is an additional control that allows you to stop all image smoothing or 

anti-aliasing on images that are scaled up or zoomed in. In other words, instead 

of a smoothed image, you see all the pixels when zoomed in.  Open the Bitmap 

Gallery and right click on the image and select Properties. In the dialog un-check 

the 'Smooth when scaled up' option. Now, no matter what View Quality you 

select the image (and all copies) will always show the un-smoothed pixels when 

enlarged or zoomed in. 

 

Note: If you use the Photo tool sharpen / blur control then images have to be 

displayed at maximum quality. So if you think the View Quality has stopped 

working, it's almost certainly because you have sharpened or blurred the image 

with the Photo tool.  

 

Saving & Exporting Photos  
Selecting the Save option will always save a native .xar file. To save a photo as a 

JPEG, PNG or other image file type it's necessary to use the Export option, or 

the shortcut Ctrl+Shift+E. You may select from a very wide range of file types, 

such as JPEG, PNG, GIF, TIFF, PDF, PSD, Flash (.swf), BMP, as well as other less 

well known types. 

 

For photos we recommend saving as JPEG (sometimes called JPG) as this offers 

the greatest compatibility and the best size / quality compromise. 

 

When you export a JPEG, an Export Preview Dialog is shown where you can 

adjust many export options, as well as compare side-by-side alternative settings 

or even alternative file types such as PNG. 

 

The Export Preview Dialog allows you to adjust the size, resolution, JPEG quality 

and even select from 3 alternative export file types if you so wish. The default 

values should be fine for all normal purposes and you can just click the Export 

button to save your photo. 

 

Things to remember when exporting:  

 First select the object or objects you want to export  
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 The default exported size of the image will be the size you see on 

screen at 100% zoom.  

 

Tip: You can control the JPEG quality in the Options tab. The default and 

recommended value is 75%. 

 

 
 

  

The JPEG system is designed so that a setting of 75 is the optimum value. We 

recommend you do not save JPEGs at 100% quality, as the results are visually 

identical to the 75% quality, only the file size and memory use is dramatically 

increased with no benefit.  When saving for use on the web it's quite possible to 

reduce the quality below 75 to increase page view speed. The Preview window 

shows the quality of any value you select.  

 

Tip: If you expect you may want to perform any further edits on your exported 

image, for example to create the image again at another size, we strongly 

recommend saving the .xar file as well. This will preserve the lossless master 

image along with all its edits and changes. 

 

Example: To resize a photo and save as a new JPEG  

This process is very quick and simple:  

 Drop your photo onto Xara Xtreme (either onto a blank page or onto 

the title bar to create a new document)  

In the Selector tool either drag a corner handle to resize the image, or enter the 

required width or height into the W or H field on the InfoBar. Check the image 

size is correct at 100% 

 

 
 Type Ctrl+Shift+E to start the export process  

 Enter a filename, and ensure JPEG is selected from the file type drop-

down  

 In the Preview Dialog simply click the Export button. 
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To save any image as a PNG go through the same process except choose the 

PNG file type.  

 

Photo Edit Attributes  
All edits performed using the Photo tool, such as any altering of the brightness, 

contrast, color, blur or sharpen values, or even the more advanced Levels 

adjustment, are all just stored on the photo as Xara Xtreme attributes. (See the 

Xara Terminology section). Just as you can alter the color of a shape or line 

without altering the underlying shape, so Photo tool attributes alter the visible 

appearance of the photo without affecting the original image (this is called non-

destructive editing).  Another way of looking at this is that Xara Xtreme just 

stores a list of edits applied to your photo, and you can change, remove or add 

new edits. You can always recover the original untouched photo, even after 

changing the brightness, resizing, or even clipping or cropping. 

 

Attributes can be copied and pasted between objects. Not only does this apply 

to traditional attributes such as line color and thickness, it also works with all 

the Photo tool attributes including the Levels settings. So this means you can 

easily copy all the enhancements made on one photo to any other using the copy 

/ paste attribute feature. For example to apply the same white balance 

adjustment (made using the Levels control) to another photo, just copy the 

edited photo to the clipboard and then select the Edit -> Paste Attributes menu 

on any image to which you want to apply the same corrections. 

 

This also applies to all other attributes of the photo, such as line width and color, 

photo coloring (contoning), shadows etc - all these can be copied from one 

photo to another using the same technique. 

 

Editing The Outline of Photos  
You can use any of the shape / line editing tools to directly adjust the outline 

shape of a photo.  Similarly you can apply outlines the same way as for any shape, 

and shadow, etc.  
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Using the Shape Editor tool you can push or pull on the sides. The Freehand tool 

allows you to re-draw the outline. This example also has a black outline and soft 

shadow added. To restore the image back to its original rectangular shape, select 

the 'Un-clip'  in the clip mode of the Photo tool InfoBar. 

 

When photos are edited this way, they are treated like any normal vector shape, 

containing a bitmap fill. This is why you can use the normal line and shape editing 

features, and indeed you can use the Fill tool to adjust the size, angle and 

position of the photo 'fill' inside the shape. 

 

Cutting Objects Out of Photos 

 

 
   

Using the drawing tools it's easy to draw around shapes and cut them out of the 

background. You can use any of the line drawing tools to do this. Perhaps the 

easiest way is using the Shape Editor tool and draw a line around the edge of the 

shape you want to extract.  Zoom into your photo and then:  
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 In the Shape Editor tool use a type of 'connect the dots' technique of 

sequential clicks around the shape, using more closely spaced clicks for 

detailed areas and fewer clicks for straight line or gentle curved areas.  

 When you've gone around the object completely, close the line to be a 

solid shape by joining the last segment to the first. This will create a 

filled shape, typically solid black.  

 You can now cut this shape out of the photo by selecting both the new 

mask shape, and the photo (shift click on the photo in the Selector 

tool) and select the menu Edit -> Arrange Shape -> Intersect Shapes.  

 Feather the results to blend the edge slightly, by dragging the Feather 

slider on the top bar to one or two pixels.  

 You can make further edits to the shape, using the line editing tools, as 

the whole photo remains inside the shape - which is acting just as a 

clipping mask.  

 

 

 

In this example the cow has been given a floor shadow using the Shadow tool.  

 

Screenshots  
In combination with a Windows built-in screen capture feature you can easily 

capture and create screenshots.  

 Press the Print Screen button on your keyboard. This places a screen 

capture of the whole screen on the clipboard. Or alternatively select 

Alt+Print Screen which will capture just the current window.  

 In Xtreme select Ctrl+V to paste, and select 'Bitmap' to have the 

results pasted onto the page. 

 

You can now crop, add text annotation, resize as required and save the results. 

It's best to save this type of image as a PNG file.  All the annotated screens of 

this Help and Manual were created this way.  
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Coloring Photos  
With any photo selected, just click on the Color Line to apply a color to the 

photo. Clicking the white color patch will turn the image black and white. 

Technically this is called a contone (it's a continuous tone from black to white) 

or sometimes a duotone.  

 
Simply click a pale yellow color on the Color Line to create a yellow contone picture. 

 

Or right click on the Color Line which shows a context menu like this, where 

you apply the selected color as either the Light or Dark color.  

 

 

You can also use the Color Editor to select any color as either the Light or Dark 

contone color. Simply select the photo, display the color editor (Ctrl+E) and 

select the Light or Dark contone from the drop-down menu at the top of the 

Color Editor. 

  

You can restore the original color of a photo by clicking the cross-hatched 'no 

color' patch on the left of the color line, or right clicking on it and selecting the 
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'Restore color' option.  

 

Integration With External Photo Editors  
While Xara Xtreme provides a great many photo editing and compositing 

features, it is not a 'pixel editor', and for these purposes you may want to use a 

separate program. Xara Xtreme makes integration with these easy. You can 

configure any external program to be launched when you double-click a photo, 

and after editing, for the photo to be automatically transferred back into your 

Xtreme document. 

 

In the Options dialog, select the Effects & Plugins tab. There is a section where 

you can select which external photo editor is launched when you double-click a 

photo.  

 

 

XPE is the basic Xara Picture Editor. Most of its functionality is now provided by 

the Photo tool directly and so this tool provides little benefit. It's here mostly for 

back compatibility reasons. 

 

The MAGIX Xtreme Photo Editor provides a wider range of pixel editing 

features and is bundled as part of Xara Xtreme. 

  

Alternatively if you select the 'Edit bitmap with this program' option and browse 

to select an external program, then this can be launched by double clicking on 

any image.  (You will probably need to Browse to your Program Files folder in 

your C drive and select the program executable .exe file). 

 

It should be understood that images transferred to and from external editors are 

transferred as uncompressed images (to avoid lossy compression / 

decompression cycles) and so this will increase the file size of your .xar file. 

   

When editing a photo in a separate program in this manner, you can carry on 

using Xara Xtreme as normal. Each time you save the image from the photo 
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editor (or just close the program and click the Save option) Xara Xtreme will 

automatically pick up the changed version and replace the original image.  So this 

means you can just continue editing the photo in the external program, and to 

see how this looks in context in your Xtreme document, just click Ctrl+S (or 

whatever is the normal Save shortcut of your photo editing software). 

 

Note: Xara Xtreme always sends the original un-clipped whole photo to the 

external editor. Any images that are enhanced (e.g. brightness altered) or 

clipped with the Photo Clip, or have any Live Effects applied, will have these 

changes missing when you edit them this way.  But when the edited image is 

returned the clip and photo attributes are re-applied to the edited image.  For 

this reason it's not recommended that you alter the size or crop images in an 

external editor. 

 

You can, of course, Undo any external edits you've applied by using the usual 

Xara Xtreme's Undo feature (it always stores a copy of the 'before' image). 

However when you save and re-open the .xar file all Undo information is lost. 

 

Editing images this way is a destructive edit. i.e. the image is permanently altered 

by the external photo editing tool, and the original cannot be recovered once 

the file has been saved and closed. 

 

Disabling External Photo Editors 

If you select the 'Edit bitmaps with this program' option and leave the field 

empty, then double-clicking on a photo will have no action. 

Resize, Rotate and Position a Photo Within Its Frame  
Photos in Xara Xtreme are treated like a 'bitmap filled' rectangle. The shape of 

your photo is really a fully editable outline around the image contained inside.  

So when you crop, or edit the outline shape, you're not affecting the fill, which is 

clipped inside the shape. 

 

Photos and bitmaps on the page are always contained within an outline shape. 

Not only can you change the shape of the outline, you can also adjust the size, 

angle and position of the photo within its frame using the Fill tool. Just select the 

photo, go into the Fill tool and you will see Fill Arrows at right angles from the 

center. (Or you can go into Fill tool, and click on the photo to select). 
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For example, to enlarge and rotate the image on the left inside its frame, select 

the Fill tool and drag on one of the arrowheads. 

 

 To resize drag on one of the arrow heads away from the center. You 

can hold Ctrl to constrain the angle.  

 To rotate the image, drag one of the arrowheads around the center.  

 To re-position the image, drag on the center handle, or hold Shift and 

drag anywhere on the image.  

 

On the InfoBar of the Fill tool, you can select the 'Repeating tile' option which 

makes the image a tiling bitmap fill. By dragging anywhere inside the shape you 

can now resize and rotate the image tile dimension. There is no better 

demonstration of the speed of Xara Xtreme than to do this with a huge multi-

megapixel image. 
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Horizon Straighten  
Using the Fill tool, as previously described, means it's easy to straighten the 

horizon of a wonky picture.  

 Select the Fill tool and click on any photo. This will show the Fill 

handles, which are arrows showing the extent of the fill inside the 

shape.  

 Drag on the end of one of the fill arrows to resize, and rotate as 

required.  

  

The following shows a landscape (created using the Panorama Stitching feature) 

that has a sloping horizon.  

 

 

In the Fill tool, drag on one of the arrowheads to rotate and resize as required. 

You can re-position the photo by dragging on the center handle of the fill 

arrows, or holding Shift and pushing anywhere on the image.  

 

Optimizing Photos And Bitmaps  
With the ever increasing resolution and file size of digital camera JPEGs, if you 

have a document containing many images, the file size can quickly become very 

large. For example, a multi-page document containing 20 full resolution JPEGs, 
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each of 5Mbytes, would produce a .xar file of over 100Mbytes. 

  
(As mentioned previously, with other graphics software this could easily be 5 or 10 times this size) 

 

What's more these photos are often unnecessarily high resolution. Reducing a 

photo from a 8 Megapixel digital camera to be 2 inches (5cm) wide on the page 

will result in this image being around 1500 dpi.  Whilst a very high resolution 

image gives greater flexibility for printing (and you can zoom in, or enlarge small 

parts of the photo), this is far higher than required for even the best quality 

commercial printing, and even more so for web graphics or HTML production. 

 

If you clip to a small part of the image, or cut-out only a small part of your photo, 

there could be large parts of hidden image outside the visible area.  For editing 

purposes this 'live crop' is a great feature, as you can un-crop, alter the size, 

position and scale and everything remains as sharp as possible. But for finished 

documents you may want to remove the invisible parts.  

 

 

The cut-out butterfly image still has the rest of the photo attached. If you go into 

the Fill Tool you can easily see this by resizing the fill inside the outline. So the 

parts of the image outside the butterfly will probably be superfluous in your final 

document. 

  

So there is a useful menu option,  Utilities -> Optimize Photo.. that 

performs three important functions:  

    • Removing invisible parts of photos  
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    • Reducing resolution of photos  

    • Converting PNG or bitmaps to embedded JPEGs to optimize file size. 

 

Selecting this menu option for any bitmap will display a dialog much like the 

Export dialog. This is what is shown if I have the clipped butterfly image selected.  

 

 

By default it will create a JPEG, omitting the parts of the picture outside the 

clipped area, and embed this into your document, replacing the old image. The 

resolution is also decreased to 96dpi - the same as you see on screen at 100% 

zoom, but this can be altered in the Bitmap Size tab of this dialog;  
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You can select any required dpi from the drop down, to enter a specific width 

and height of the bitmap.  For screen use (e.g. web and HTML) it's not necessary 

to have a resolution greater than 96dpi.  For printing, a photo resolution of 

150dpi gives very good results, whilst 300 dpi will provide the highest quality 

commercial printing. (Most people cannot tell the difference between 150dpi and 

300dpi, but the 300dpi requires four times as much memory or file space). 

   

You can adjust the JPEG quality, just as you can when exporting a JPEG, using the 

Options tab. 

 

 

Note: The optimum JPEG quality is 75%.  

WE DO NOT recommend saving JPEGs with a quality at 100% - they are 

virtually indistinguishable from JPEGs saved at 75%, but use considerably more 

memory and file space. The final size of the resulting JPEG is displayed under the 

preview window. 

 

Important: The Optimize Photo is a 'destructive' operation. When you save 

the file the removed parts of the image are lost, and the resolution changed 

permanently (you can of course undo the changes while the file is open for 

editing). 

 

You can optimize multiple photos at once if you want them to all have the same 

DPI. Select the photos you want to optimize and then choose the Optimize 

operation as described above. The Optimize dialog shows the settings and 

preview for just one of the selected photos, but when you click the Optimize 

button the same settings are used to optimize each of the selected photos. 

 

Converting Objects or Drawings to Bitmaps 
You can easily create a bitmap from any object, or part of your drawing, 

including from other bitmaps. The bitmaps can be any size or resolution and can 

contain transparency. You can also create bitmaps with reduced numbers of 

colors which can be useful for web use. 

 

To create a bitmap from objects:  
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1. Select the object/s on the page 

2. Choose Arrange > Create Bitmap Copy (or type Ctrl+Shift+C) 

3. In the dialog box, select the Color Depth, the size and other options.  

 

For maximum quality select a Color Depth of True Color, or if you want 

transparency to be included select True Color + Alpha (Alpha transparency is 

the technical term).  You can create bitmaps with fewer colors by selecting a 

Color Depth of 256 colors or less. This also provides control over the Dithering 

and Palette options. These options are described in the section on exporting 

bitmaps. 

 

Note this always creates PNG images, which are the highest quality lossless 

image type.  However for full color photo purposes, these require a lot of 

memory and file space. Use the Optimize Photo option to convert PNG images 

into embedded JPEG images to reduce the file size. 

 

Photo Documents  
Sometimes it's useful to work on one photo alone, rather than treat them as 

'objects on a page'. This is called a Photo Document or 'photo mode' in Xara 

Xtreme, and it behaves more like a traditional photo editor. You can create a 

photo document in a number of ways: 

  

 Drag a photo file from your File Explorer onto the title bar or other bar 

of Xara Xtreme  

 Select File -> Open and select a photo file  

 Create a blank Photo Document by selecting File -> New -> Blank 

Photo. 

 

Photo Documents are characterised by the following behavior differences 

compared to traditional Xtreme documents:-  

 There is no visible white page. In fact the page dimensions are set 

automatically to match the photo plus any other objects you've added. 

So initially when you load a JPEG, the page dimensions are set to match 

that of your photo exactly. If, for example, you add some text 

underneath your photo, or you add a shadow, the page immediately 

expands to fit in your additions. Or if you scale down your photo in 

the Select tool to reduce its size, the page dimensions reduce to 

match. So you don't need to continually manually adjust the page 

dimensions to match your design and, unlike with most photo editors, 

you don't need to plan in advance the dimensions of your finished 

photo.  

 Photo documents have a 1 pixel grid by default and snap to grid is 

turned on. This makes it easier to get pixel-accurate crop or clip 
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regions.  

 The pasteboard (the area around the photo) is a darker color. This 

makes it easy to distinguish at a glance between photo documents and 

drawing documents.  

 The document zoom is set so that the photo fills the view and the 

photo tool is automatically selected as the current tool.  

 Dropping additional photo files on top of an existing photo just adds a 

new photo to the document instead of replacing the photo in its frame.  

 The pixel smoothing options are altered. By default it selects the Very 

High Quality display mode, which is best for images scaled down or 

zoomed out. It also has pixel smoothing turned off when zooming in, 

so you can see the pixels at very large zoom factors. 

 

In all other respects Photo Documents behave like normal Xara Xtreme 

documents. You can use all the normal drawing and text tools as usual.  If you 

want to create a Photo Document of a given size, you can alter the 'canvas' or 

page size by selecting Utilities -> Options and selecting the Page tab and 

entering the required dimensions. 
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The Photo Tool 

The Photo tool provides a direct and very fast way of cropping, adjusting the 

brightness levels and sharpening photos, even for ultra-high-resolution images. 

This tool provides: 

• One-click auto-enhance of photos. This is particularly good with dull, 

underexposed images.  

• Manually adjust the brightness, contrast, color saturation and blur or 

sharpness of photos. 

• Crop images. This is 'live crop' so you can un-crop and adjust the crop at 

any time. 

• Display a brightness levels histogram of your photo.  

• Adjust the brightness levels curve for more advanced levels control.  

• Correct color casts or white balance.  

• A single-click Compare function to quickly compare changes against the 

original.  

• Easy Copy / Paste all photo enhance edits between different images.  

All these operations are interactive with live update. As you adjust the values, 

the image is updated instantly. They are also all non-destructive, meaning that 

your original image is not altered and you can always adjust or remove any 

adjustment. 

 

In addition there is a shortcut to the anti red-eye feature, and an automatic 

panorama stitching feature. 

 

 

Photo Tool Benefits 
There are three major benefits from this tool: 

 

• It's non destructive  

• It's very, very fast, even for huge images  

• It requires no memory  

 

Benefits explained in more detail 

The non-destructive point means that all edits do not affect the original image. 

You can adjust or remove the edits and the original image remains unaffected. 

This differs from most photo editors where an alteration makes a permanent 

change to the pixels of the photo. In Xara Xtreme you can adjust the settings as 

many times as you like in the sound knowledge that you are not altering the real 

actual original photo data. 
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Even the crop feature is non-destructive (which is why it's called Clip). You can 

restore the cropped areas and adjust or enlarge the crop region at any time, 

even after you've saved a file. 

 

The speed point is self-evident, but a good demonstration of the speed is to 

rotate a very high resolution photo. In other tools you usually have to enter a 

number of degrees, and then wait for this to be processed. In Xara Xtreme you 

can drag rotate a full resolution image in real time (or enter any rotation value). 

And Xara uses high-quality bi-cubic image sampling to ensure the highest quality 

results. 

The no-memory point refers to the fact most photo editors need to make a 

copy of a bitmap in memory in order to provide an Undo capability, and usually 

one copy each time you adjust or edit it. For large hi-res digital photos this can 

mean very large amounts of memory being required for your photo editing 

(consider that a typical 8Mpixel digital photo requires 32Mbytes of memory - 

make ten edits and that's 320Mbytes of memory). Xara Xtreme requires zero 

memory.  You can make as many edits as you like, make as many copies of your 

photo in your document, and the additional RAM and file space required by 

Xtreme for this is zero. 

 

Finally JPEG images are embedded into the native .xar file, and not expanded into 

raw images as they are in other graphics tools. This means a native file size 

typically 10 times smaller. Combine this with the zero memory copies, the real-

time enhance features described above and it's quite possible to have file sizes 30 

times or more smaller than with other graphics tools. And that means they are 

much, much quicker to handle, save, process and transfer. 

Using The Photo Tool  

When you select the Photo tool  the InfoBar is shown which provides 

access to all the features. 

 

 

The Photo tool has two modes - Enhance mode where a set of controls 

allow you to adjust the brightness, contrast, saturation and blur / sharpness 
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values (shown above). 

 

A second Crop mode, selected by the second icon on the left side of the 

InfoBar, operates the interactive crop tool. In Crop mode the InfoBar changes to 

look like this: 

 

 

Five icons remain common to both modes, and these provide access to the 

Levels dialog, the anti red-eye, Panorama features and the Rotate 90° functions. 

These are described below. 

Enhance: Altering the brightness, contrast, color 
saturation, blur or sharpness 
When you select the Photo tool for the first time it is in Enhance mode, meaning 

that controls are provided for adjustment of brightness, contrast, saturation and 

blur/sharpen. You can either enter values directly into the text fields or use a 

small pop-up slider for adjusting the values interactively.  

Pop-up Slider Controls 

 

 

The pop-up sliders can be used in one of two ways:  

• Click and release on the pop-up arrow. The slider control now remains 

on screen and you can adjust the values as many times as you like by 

dragging the slider control.  Alternatively if the mouse is held over the 

control, the mouse-wheel can be used to make small adjustments up or 

down. The slider will hide when you click anywhere else in the document.  

• Or you can click-and-hold the mouse button down, and drag over the 

slider bar to adjust the value. When you release the mouse the pop-up 

vanishes. This is a quicker, more direct way as it requires only one click-

drag-release to alter the values. 

Auto Enhance 

Clicking the Enhance button will analyze the overall brightness and contrast of 
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the picture and automatically adjust the enhance values to obtain the best image. 

It is particularly effective with under-exposed (dark) images. After applying 

automatic enhancement to a photo you can adjust the values that were chosen, 

using the controls to the right of the Enhance button.  Clicking the Compare 

button will restore the original, clicking it again restores the last enhance values. 

 

Brightness  Contrast   Saturation  

 

The image is altered as you adjust these values. The saturation alters the color 

intensity. At the minimum setting of -100 this will make a picture black and 

white. 

Blur / Sharpen  

This control blurs images if it's taken below zero, and sharpens images above 0. 

For sharpen it's recommended that only small values be used, and typically only 

on images that have been reduced in size a lot. 

Compare & Restoring the Original  

The Compare button can be used to reset all the Enhance and Levels Tool 

values back to their defaults, returning your photo to its original state. Press the 

Compare button a second time, your previous values are reinstated. Therefore 

you can use the Compare button to quickly toggle between your edited photo 

and the original photo so you can see the effects of the changes you've made.  

Because all the Enhance and Levels alterations are non-destructive, pressing 

Compare simply removes the enhance attributes, so restoring the original image. 

The Compare button can be used at any time after an image has been altered. 

Rotate by 90° controls 
 

  

 

The two rotate icon will rotate the selected photo or photos by 90 degrees anti-

clockwise or clockwise. 

 

Cropping or Clipping Images  
The Clip (or crop) tool allows you to rapidly clip your photo directly on the 
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page.  This is a non-destructive operation meaning that you can both adjust the 

clip region after you've copped the image, and also un-crop to restore the whole 

image. A way to look at the process is that it just adjusts the picture outlines, but 

the whole picture remains clipped inside the rectangular outline.  This is why it's 

called a Clip, and not Crop, although it serves the same goal as a traditional 

Crop tool. 

You can either click the Crop mode button , or as a shortcut, just start 

dragging on or across the photo with the Photo tool selected.  This alters the 

InfoBar to look like this: 

 

As you drag over the photo, the clip rectangle is highlighted. 

 

• You can adjust the region by dragging on the corner or side handles  

• You can push the region around by just dragging inside the clip region  

• Select the Clip button or just double click inside the clip region to 

perform the clip operation. 

 

You can tell whether a photo has been clipped or not from the Status bar which 

will describe it as a 'Clipped photo'. 

Rule of Thirds 

There's a photography guideline that helps the composition of many 

photographs called the 'Rule of Thirds'. Put simply this involves placing key 
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objects in your photos at thirds across your picture. For example it's often 

better to position the horizon one third of the way down a picture rather than 

being across the center. When you drag a clip region across your photos lines 

are displayed at thirds across and down the image to help position objects to 

follow these composition guidelines. Tip: Search for 'Rule of Thirds' on Google 

for more information.  

 

Clear  

Press the Clear button, or just click outside the marked clip region, to clear the 

current clip rectangle. 

 

Un-clip 

Press the Un-clip button with any clipped photo selected, to restore the 

original photo. This restores the clip rectangle, which you can adjust or clear by 

clicking outside it. 

 

Adjusting the clip region 

Because the Un-clip button restores the clip rectangle (showing the area outside 

faded), you can easily make fine adjustments to a clipped photo. Just select the 

photo, press the Un-clip button and adjust the sides of the clip rectangle as 

required. Double click inside the photo to clip it again. 

 

Width / Height  

After drawing a clip rectangle, you can enter values directly into the Width and 

Height fields on the InfoBar to set the clip rectangle dimensions to exact values. 

 

Lock Aspect 

Select the Lock Aspect checkbox to constrain the clip rectangle to a specific 

aspect ratio as you drag. The radio buttons to the right of the checkbox 

determine the aspect ratio used. Select Current to maintain the aspect ratio to 

that of the photo before the clip. Note that the clip rectangle automatically 

changes between landscape and portrait orientation as you drag a corner of the 

rectangle.  So if you drag sideways it tends to create a clip in landscape 

orientation. If you drag downwards more, then it will create a clip region in 

portrait orientation. 

 

The common preset crop aspect ratios are available of 4:3 (most consumer 

digital cameras and old-style TVs and monitors), 3:2 (that of traditional film 

cameras and higher end SLR digital cameras), and 16:9 (aspect ratio of 

widescreen TVs). 

 

You can override the lock-aspect option by using the Ctrl key while dragging. So 

if you're dragging out a clip rectangle (or adjusting one) without aspect ratio 
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lock, then holding Ctrl will lock the aspect to the last selected aspect ratio. 

Similarly if you have lock aspect option on then Ctrl will temporarily un-lock the 

aspect ratio. 

 

Clipping in Photo Documents 

In Photo Documents, there is a one-pixel grid applied to the photo (when at 

96dpi, the default resolution) and the clip rectangle snaps to this grid. This makes 

it very easy to get pixel exact clipping. For highly accurate or exact pixel 

snapping it's recommended to operate in Photo Document mode and to zoom 

in so you can see the pixels clearly (see the Help section on Photo Documents 

for more information.) 

 

The Brightness Levels Dialog  

In the Photo tool click the Levels tool icon.  

 

The Levels tool provides detailed control over the brightness levels of photos. 

It's a very powerful, multi-purpose tool that not only shows a histogram of the 

brightness levels of the photo, but provides a greater degree of control than the 

simple Brightness or Contrast controls.  It can lighten shadows without affecting 

other parts of the picture. It can adjust the white balance of a picture and also 

the black and white points. 

 

The red histogram graph shows the distribution of brightness levels in the 

selected picture, ranging from the blackest shades on the left to lightest (white) 
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shades on the right. The height of the red graph indicates the amount (i.e. the 

number of pixels) of each shade used in the picture. Typically a correctly 

exposed photograph would show a spread of brightness levels across the range, 

dark to light, as in the above example. Here are some pictures and example 

histograms. 

 

1. The first image shows a good spread, from the darkest to lightest shades, 

with a predominance of mid-brightness shades.  

2. The second image is obviously very dark, and the histogram reflects this 

with peaks at the dark (left) end. 

3. The third image has peaks at the bright (right) end which are typical for 

images that have a bright sky. There is nothing wrong with this and the 

overall exposure is about right and you can see a good distribution of 

shades across the histogram. 

 

Note: The histogram is scaled vertically to fit within the display area. So when 

you have large peaks such as the second and third examples, the whole graph is 

compressed downwards. 

 

There are five main controls used to adjust the brightness levels. These are the 

three small triangles under the histogram, and the two further triangles at the 

bottom.  Each of these has a corresponding field and numeric value. 

 

By adjusting these controls you can alter the brightness level, to obtain a better 

distribution and thus a better exposed image.  Here's an example of an image 

with very poor contrast (common for photos taken of distant objects with a 
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large zoom). 

 

 

The histogram shows a narrow range of shades, hence the low contrast of the 

image. The goal is to spread the narrow range of shades over the full black to 

white range.  By dragging the black point control so it's under the left edge of the 

histogram, and the white triangle so it's under the right end, this will re-map the 

brightness levels.  Doing this now shows two histograms overlaid; 

 

 
 

The pale red overlaid histogram is the new histogram, and you can see this alter 

as you drag the control around. The black and white points have been dragged 

inwards. This has the effect of re-distributing the shades (the pale red overlay) 

which you can see now cover a wider range of shades. And sure enough the 

photo itself is considerably enhanced. 

Adjusting brightness 

Dragging on the center gray triangle adjusts the brightness (technically this is 

altering the gamma). It does the exact same thing as the brightness slider on the 

InfoBar. 
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The brightness slider alters the darker shades in a picture more than it does the 

lighter shades, so it is particularly good for revealing details in shadows. 

Selecting the black, gray and white points  

 

 

The three eye-dropper icons can be used to pick the black, gray or white points 

on the photo, and adjust the three controls for you automatically.  These tools 

have the advantage that they also adjust the white balance or color cast that 

your photo might have. 

 

Click and drag one of the icons from the Levels Dialog over your photo. As you 

do this you will see the photo change. Release the mouse buttons when you're 

happy with the change. 

  

So to set the black point automatically you'd drag the black eye-dropper over 

the blackest part of your photo.  Similarly you'd drag the white eye-dropper 

over the whitest part of your image. 

Note: These are dragable buttons - they do not work by selecting the button 

and then clicking again on the photo. Instead you must drag them over the 

photo. These are interactive, so as you drag the picture is changed.  

 

Color cast - fixing the white balance 

The middle of the three eye-droppers sets the gray point and this is mostly 

useful for altering the white balance of your photos.  You drag it from the Levels 

Dialog, like the others, but drag it over any point in the picture that is meant to 

be gray. In doing this the balance of colors is altered to try and make the item 

under the mouse pointer a pure shade of gray, and thus alters the color balance 

of the whole picture. 

 

If you have a photo taken with the wrong light setting, they will come out orange 

or blue. This control can help fix this, although in bad cases it will never be 

possible to make them perfect. 

 

Tip: If there are no gray objects in the picture, find anything that is meant to be 

white and look for an area that's in shade or less than bright white. 

Tip: If you have multiple pictures taken with the same color cast, you can copy 

the correction from one to another using the Copy / Paste Attributes feature. 

Here is an example, a snow scene, that is badly under-exposed, and with a 
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strong blue cast. Its histogram on the right shows the white levels are poor. 

 

By dragging the white eye-dropper from the Levels dialog over the whitest part 

of the image, it not only restores a better overall histogram, but also corrects 

the blue cast so that the white snow really is white. 

 

 

The corrected histogram now shows a much better balance (it's largely at the 

white end, but that's to be expected in a snow scene). 

 

 

Auto Levels 

The Auto button will automatically adjust the white and black points to 

correspond to the lightest and darkest shades in the selected picture. This 

works better for some images than others (the above snow scene works 

perfectly, so in fact this can be corrected with a single click). 
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Reset 

The Reset button will reset all Levels parameters back to their starting values. 

The Compare button on the Photo tool InfoBar also does the same thing, but 

has the advantage that pressing it again restores the altered settings. 

 

Advanced Levels - The Green Line 

For the more advanced user, the Levels control is really mapping the range of 

input brightness levels to an alternative set of output levels. Overlaid on the red 

histogram is a green line that represents the mapping function. 

 

The default straight line means no change, so dark shades are mapped to dark, 

and light to the same light shades. But as you alter the controls the green line is 

altered to reflect the new mapping. So, for example, increasing the brightness or 

gamma control will change the line like this; 

 

 

You can see now that it's no longer a straight line mapping, and that the darker 

input shades will be mapped to corresponding lighter output shades.  

 

Using one of the low contrast examples above, this is the altered histogram, 

showing the before, after and altered green mapping function line. 
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You can see the black and white points are moved inwards. This is reflected in 

the green line which shows that mid-shades are now mapped to dark, and the 

lightest white points (about 80% along the horizontal) are now mapped to white. 

Thus the narrow range of input shades is mapped to the full dark-to-light range 

of output shades. 

 

Joined RGB - or separate Red, Green and Blue 

When altering the overall brightness or contrast, this operation is performed 

equally across the RGB component colors that make up the full color image. In 

other words the color balance is not altered - all colors are affected equally - it 

just alters the overall brightness levels.  The drop-down menu at the top of the 

dialog shows Joined RGB to reflect this.  However you can adjust the levels of 

each red, green or blue component (channel) separately, by selecting from the 

drop-down list. And each of these color components has its own set of controls 

that work independently of the 'Joined RGB' controls.  By adjusting the curves of 

one color component only, say blue, you will affect the overall color balance. So 

this is a way in which you can manually add or remove more red, green or blue 

to any picture. 

 

Note that when you use the Auto button or drag the black, gray, or white eye-

dropper pickers, these functions alter the separate RGB components, rather 

than the 'joined RGB' controls. This is how they correct the color balance. The 

side-effect of this mean the joined RGB controls appear not to have changed. 

 

Output Levels 

The two lower controls adjust the minimum (black) and maximum (white) final 

output levels. Adjusting these has the effect of reducing the contrast. 

 

Tip: It is usually recommended that for printing purposes the photos do not 

contain pure white, but instead have a maximum 'whiteness' of around 90%, 

especially if being printed in black and white. The histogram makes it easy to see 

if there is a lot of pure white (peaks at the far right end), and by adjusting the 

white output level slider you can easily control this. 
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Dragging the White Output Level slider inwards slightly alters the green line 

thus: 

 

 
 

Meaning the maximum white value is brought down slightly. 

Applying the same Levels correction to multiple images 

It's common that photographs taken together under the same 

conditions suffer from the same exposure or color cast problems.  It's 

easy in Xara Xtreme to copy any Levels adjustment from one image 

to any other. Just Copy the source image to the clipboard in the usual 

way (Ctrl+C), and then select Edit -> Paste Attributes (shortcut of 

Ctrl+Shift+A). 

Photo Tool Notes 
1. The Levels dialog works in conjunction with the Brightness and 

Contrast sliders. You can use both sets of controls together or 

separately. All will alter the overall brightness levels, and all changes 

are reflected in the histogram and green mapping line.  

2. The Levels dialog is non-modal, which means that while it's on screen 

you can continue to use Xara Xtreme as usual. It will update to show 

the histogram levels of any photo selected, and will show blank if none 

or multiple photos are selected.  

3. You can select different photos while using the Photo tool by just 

clicking on them. This also works for photos inside groups.  

4. If you click and drag, while in the Photo tool, it will start a crop on the 

photo that you started dragging on. Or if you start dragging on the 

background the crop will be applied to the first photo you touch 

during the drag.  

5. The Un-clip button will restore the outline of any clipped shape, 

including bitmap filled shapes, to that of the complete photo or bitmap 

used as the fill. So for example if you use the Fill Tool to adjust the size 

or angle of the photo, then un-clip will restore the outline of the 

whole image. You may have to select the Clear button to clear the 

crop rectangle (or click outside the rectangle).  
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6. All Photo operations are fully undoable. Unlike traditional photo or 

pixel editors, the original photo is never altered. So this means you can 

make as many changes as you like, as often as you like, and save and 

load .xar files as often as you like, and there is no degradation of the 

image (all edit operations are non-destructive and loss-less).  

7. To save a photo, use the Export option, not the Save option (which 

only saves a native .xar file).  

8. All the Photo tool options, including the Levels control, operate on 

bitmap filled objects, as well as stand-alone photos. 

 

Red-eye Correction  
The Photo tool InfoBar has a shortcut to launch a separate red-eye removal 

tool. This will either launch the Xara Picture Editor (XPE) tool or the Magix 

Xtreme Photo editor tool, depending on which external editor is configured in 

the Options Dialog.  The default case is to use the XPE. 

 

The process is very similar for either editor: 

Red-eye correction in XPE (Xara Picture Editor) 

• Select the photo and click the red-eye button on the Photo tool InfoBar. 

This will launch the external XPE photo editor  

 Zoom in to the face, so the eyes are clearly visible. The easiest way is to 

select the Magnifier icon and drag over the face to zoom in 
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 Select the red-eye tool icon, and click in the center of the eye and drag 

outwards  

 Select the large 'check' icon to save the changes back to Xtreme. 

Red-eye correction using Magix Xtreme Photo  

 Select the photo and click the red-eye button on the Photo tool 

InfoBar. This will launch the external photo editor in the red-eye 

tool 
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• Zoom in to the face so the eyes are clearly visible. The easiest way to do 

this is hold Ctrl and use the mouse-wheel (same as in Xtreme)  

• Follow the instructions down the left, which basically say to draw over 

the red-eye to make it black  

• Click Apply and close the program.  

The updated image will be exported back to Xara Xtreme and will replace the 

old version. 

Notes about red-eye correction: 

• If you have configured a separate external photo editor in the Options 

dialog, this will be launched when you click the red-eye button.  

• Fixing red-eye using the XPE is a non-destructive process that requires no 

additional file space. If you open the photo in XPE afterwards (double 

click the photo) you can remove or edit the red-eye fixes. 

• Red-eye, or any photo edits, done by external editors such as Magix 

Xtreme Photo, do require additional file space since a full sized copy of 

the image is made in the process. 

•  

Panorama Stitching  
Xara Xtreme includes a tool that can automatically stitch together up to 6 

photographs into a single wide, high-resolution panorama. Creating high-quality 
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panoramas can be a very complex and technical process, often requiring special 

equipment or lenses and accurately exposed and aligned photographs. The 

panoramic stitching feature built into Xara Xtreme requires none of these, and 

can use photos from an every day digital camera, so that anyone can create 

outstanding quality panoramic images in a few minutes. 

 

This tool features: 

• No high end camera required, and no tripod required  

• Automatic estimation of the focal length to warp the images to reduce 

fish-eye effect  

• Automatic barrel, pincushion and vignette adjustments  

• Automatic exposure correction  

• Automatic detection of shared overlap points and seamless blending of 

joins  

• Automatic cropping of the final result. 

To create a panorama you need to take a series of separate photos from a 

central position. Ideally each photo would overlap the next by approximately 

30%, although it will work with more or less overlap. 

 

The process of creating a panorama is very straightforward: 

1. Import each of the photos and arrange them on the page in the 

correct left to right order. There is no need to try and position 

the overlaps correctly  

2. Select all the photos you want to stitch together  

3. Click the Panorama button on the Photo tool InfoBar. 

 

It will start the process of stitching - which will continue as a background 

process. A pop-up status window shows the progress through the various 

stages, although you can continue using Xara Xtreme as normal while this 

happens. When the process is complete the resultant panorama image is 

imported onto the page.  Note it does not replace the original images, which you 

can delete if you no longer require them. 
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Three example photos of a landscape. Each overlaps the other (in this case a bit more 

than necessary). 

 

 
 

The resultant single panorama image, with seamless joins. 

Optimizing images 

Xara Xtreme will always stitch photos at the full resolution, even if you reduce 

the size of the image on the page. This is often a desirable thing since it produces 

the maximum quality, highest resolution results. But it does mean that the 

stitching process can take a few minutes. So sometimes you may prefer to 

reduce the resolution of the images before you stitch them together, especially if 

you only require a medium resolution final result, perhaps for the web. 

 

To reduce the resolution of any image, reduce its size on the page to the 

required size and then use the Utilities -> Optimize option. Select the Bitmap 

size tab and the required resolution from the drop down. 96dpi represents the 

same resolution as the screen although it is sometimes beneficial to have a 

higher a resolution, such as 150dpi. This will replace the photo with a lower-

resolution JPEG. 

 

Note that the panorama stitcher works better with higher resolution images (it's 

easier for it to find matching points on the photos). 

 



 

 

 

80 

 

Release Notes: Xara Xtreme 4 

When you get the stitched image back, this is stored as a PNG image in Xara 

Xtreme.  This is the highest quality, but takes a lot of memory and file space - 

especially if it's a high-resolution panorama. (The Bitmap Gallery will show you 

how much.)  Therefore you can usually benefit from reducing the resolution of 

the final image and converting it to a JPEG instead. Again use the Utilities -> 

Optimize option for this. 

Notes: 

• The panorama stitcher expects the images to be the same resolution and 

size.  

• Try to avoid taking pictures with moving objects in. These can confuse the 

system since the same object might appear in different places, or not at 

all.  

• Try to keep the horizon at the same approximate position on each photo. 

Hint: By taking photos in a portrait orientation, you can get maximum 

vertical coverage. 

 

Upgrades to Panorama Studio 

There is an optional upgrade to a more flexible and powerful Panorama Studio 

program. This provides more features and controls over the stitching process.  

Xara Xtreme Pro users get this separate program for free, bundled on the 

product CD. 

 

When Panorama Studio is installed you will be given the option to use it instead 

of the standard version when you select the Panorama button. 

 

Rotate by 90° controls 

 

  

 

The two rotate icon will rotate the selected photo or photos by 90 degrees anti-

clockwise or clockwise.  It performs the same action as rotating the object 90 

degrees using the Selector tool, but is simply a more convenient way or re-

orienting photos. 
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Live Effects  

The following new Live Effects have been added. If you select the Live Effects 

tool you will find them listed in the ‗New‘ drop down menu. 

Art Filters  
Painting: This effect creates paintings which feel realistic by trying to "redraw" 

the content of the image using a pre-defined brush shape. With the many 

parameters on the Brush, Size, Direction, Color, Transparency and Paper tabs 

you can specify how this brush shape is used, based on the original image. It's 

best to try the settings and experiment with the parameters and the effects they 

have. 

 

Color Filters 
Channels: Exchange the color channels of the RGB color model. 

Chromatic Aberration: Sometimes described as 'purple fringing' is a type of 

image distortion caused by a camera lens. Chromatic aberrations are caused by 

the cameras lens not focusing different wavelengths of light onto the exact same 

focal plane (the focal length for different wavelengths of light is different). The 

index of refraction for blue light (short wavelengths) is larger than that of red 

light (long wavelengths). The amount of chromatic aberration depends on the 

dispersion of the glass. Chromatic aberration makes images appear fuzzy. 

Selecting this option simulates it and creates an interesting artistic effect. It can 

also be used for correcting images taken using cameras with a poor (very small) 

lens, which contain the described shift of red and blue shares. 

Color Balance: Targeted color balance for bright, middle and dark areas of 

specified colors. Poor coloring in an image can be corrected by changing the 

balance between red and cyan, green and magenta, and blue and yellow. 

Color with Gradient: Colors an image with a color gradient available from the 

list. The criterion for coloring may be brightness, saturation, hue of the red, 

green or blue channel. 

Hue/Saturation/Brightness: Correct hue, saturation, brightness of the image 

in the effects dialog and check the result in the preview. 

Negative: Creates a negative of the area to which the effect is applied. 

Poster: A normal RGB image consists of 256 brightness values for red, green 

and blue. With poster you can reduce these brightness values to a new value in 

the range of 2-256. So, the image will lose colors due to this effect: The less 

grades of brightness, the higher the color loss. 

Shade Curve: Manually correct all color values in an image. By changing the 

gradient of the shade curve you assign new brightness values to the red, green, 

and blue channels (i.e. all channels simultaneously). The starting value in each 

case is a straight line from bottom left to top right. Areas which are corrected 
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upwards will be brighter, otherwise darker. 

Threshold: Creates an image of only two hues. Colors with a brightness under 

the limiting value are assigned to the minimum color, colors above it are 

assigned to the maximum color. 

 

Deformation Filters:  
Barrel/Pincushion Correction: Barrel distortion is an effect often associated 

with wide angle lenses that causes an image to be spherized at the center. 

Pincushion distortion is an effect caused by zoom lenses or telephoto adapters 

that causes an image to appear 'pinched' at the center. Selecting the 

Barrel/Pincushion correction option allows you to correct barrel or pincushion 

image distortion, or add them to an image as an artistic effect. The background 

color of the resulting image borders can be set under "Background". Select the 

"Avoid Borders" option to zoom further into the image and hide the 

background. 

Concentric Waves: Creates circular waves around the center of the 

image/object, similar to a stone dropping into water. Wavelength and amplitude 

can be set in the filter's dialog window. 

Dent/Bump: Creates a dent or bump around the center of the image/object. 

Use the slide control in the dialog window to regulate the intensity and the type 

of the effect. 

Even Waves: Superimposes the image with horizontal and vertical waves of 

adjustable length, amplitude and phase. 

Fisheye-perspective: Distort images to look as seen by a fish so that the 

center of the image bulges forward. Adjust the intensity of the bulge by moving 

the slider from right to left. In the above dropdown menu you can add an 

additional effect to the bulge. The "Normal" setting here means that the "clean" 

fisheye effect will be applied. By using the slider next to the flip menu you can 

adjust the transparency of the entire effect when using an additional effect. 

Moving it to the leftmost position gives the maximum effect, while only the 

original image is displayed when set to the right. 

Liquid Color: This tool is ideally suited to create caricatures and deform your 

images. A click on the icon opens a preview in which the active image area can 

be edited with the editing modes listed to the right. Use the "Brush size" and 

"Thickness" sliders to regulate radius and the effect of the current mode. 

Deactivate the respective direction arrows to protect the image from 

modifications in a horizontal or vertical direction. "Reset" returns you to the 

original state. 

Warp: Creates a warp rotating around the center of the image/object. Intensity 

and direction can be regulated with the slide control. 
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Distortion Filters:  
Add Noise: Generates "random" noise and superimposes it on the image.. Use 

"Density" and "Intensity" to limit the intensity and deviation from the original 

color value. If "colored" is not ticked, the color of the pixels is preserved, they 

will only become brighter or darker. 

Diffuse: The pixels in the image are dispersed like grains of sand. Select the 

intensity by defining the maximal horizontal and vertical dislocation. 

Maximum: Searches for the brightest pixel in the defined area and replaces the 

current pixel with that value (see Median). 

Median: This effect calculates the median of the pixels within the area defined 

by "Horizontal radius" and "Vertical radius" and replaces the current pixel with 

that value. 

Minimum: Searches the darkest pixel in the defined area and replaces the 

current pixel with it (see Median). 

Noise Reduction: Noise reduction is a soft-focus effect that does not make 

the image fuzzy.  

Noise reduction (selective): The selective effect version changes only those 

pixels whose color value exceeds that of neighboring pixels by a specific 

threshold value. The "Very Strong Correction" setting includes the next 

neighboring pixels (a radius of 2 pixels) in the computation. 

Remove Stains: This effect calculates a mean color value within the defined 

"Radius" which only becomes active if the new color value deviates from the 

original by more than the "Limit". By trying out parameters, preferably with a 

soft brush, you can make stains, dust and scratches invisible on the image. 

 

Other Filters:  
User Filter: Use this effect to create your own filter by combining a pixel value 

with neighboring pixels. In the 5x5 matrix, enter values in accordance with the 

weighting of the pixels (e.g. 2 means twice the value). The center field of the 

matrix is the point to which the effect is applied. All pixels of the matrix are then 

added in accordance with their weighting, divided by the dividend and the 

compensation value is added to the result. The result then replaces the pixel in 

the center of the matrix. The best way to understand the effect is to experiment 

with it. 

 

Sharpen Filters:  
Unsharp mask : This filter is a high-quality focusing tool (although the name 

might be confusing). The name is derived from the fact that during the focusing 

process the image is compared to a soft-focus copy, and the differences are used 

to enhance contrasts. With 'Radius' you set the radius within which the filter 

searches. 
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Soften Filters 
Camera Zoom: Creates an effect similar to a fast camera zoom. In addition to 

the effect intensity, you can select between zoom in and zoom out, and choose 

the zoom depth. 

Gaussian Blur: Creates a blurred image, but in contrast to "Blur", pixels are 

weighted. Pixels further away from the point of focus are less important than 

pixels closer to it. The name is derived from the method of data weighting with 

the help of a Gaussian bell curve, a function that takes place around the pixel to 

be processed. Here you can also define the "Radius" within which pixels are used 

for calculation. 

Gaussian Blur (Smart): This function is similar to the Gaussian blur, but with 

the significant difference that for pixel blurring only those neighboring pixels are 

used, where their color doesn't deviate more than the given "Threshold" 

parameter. This leads to blurred areas with similar colors, while contrasting 

edges are preserved. 

Motion Blur: This function creates a directional blur, similar to that on a photo 

taken with a slow shutter. Use "Distance" and "Direction" to define the intensity 

and direction of the effect. 

Rotation: The effect is similar to that achieved by quickly rotating a camera 

while taking a picture. Available parameters are intensity and mode (rotation left, 

rotation right, and rotation amount). 

Blur: Creates a blurred image by averaging an area of points. "Horizontal radius" 

and "Vertical radius" specify the number of pixels used for blurring in a 

horizontal and vertical direction. 

 

Stylising Filters 
Bumpmap: This effect creates a relief view with the difference that you have a 

light source that you can position. The resulting lighting effect makes the image 

look very metallic. Experiment with the position of the light source, intensity, 

unevenness and, above all, the height and width of the light cone to find the 

optimal lighting. 

Emboss: Makes the image look as if it is embossed in metal. 

Find Edges: Finds edges in the image. The thickness of horizontal and vertical 

edges can be set with the associated slide controls, and also the intensity of the 

effect. 

Relief: Creates a relief view of the image. Use 'Depth' to specify the intensity 

and 'Direction' to define the direction of the light. Additionally, you can select 

whether the edges of the relief are gray or in the color of the image, or whether 

the relief is added to the image. 

 

Video Filters 
Deinterlace: This effect is mainly intended for snapshots of video images.. Use 
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"Even" or "Odd lines" to select which field to remove and "Interpolation" to 

define whether the lines of an image are simply doubled, or whether the missing 

lines are to be interpolated. 
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Other Enhancements in V4 

Color Handling 

The Color Sampler 
The color line now includes the Color sampler tool (which used to be in the 

color editor) and the tool has been improved.  

The Color sampler no longer simply samples the screen (RGB) color. Instead if 

you point to a shape with a solid fill color, the Color sampler will pick up the 

actual color of that shape, including the color model, so the color is copied 

exactly to the selected object(s). If the target color is a Named color, instead of 

simply copying the color, the Color sampler will apply the same Named color to 

the selected object(s). If the object under the mouse pointer is complex (eg. has 

transparency applied) and the Color sampler cannot determine the actual vector 

color, it drops back to the old behavior of simply sampling the screen RGB 

color. 

Another addition is that the Color sampler shows a small pop-up at the mouse 

pointer which indicates the color that is being sampled at that point. This will 

either be the palette color name, the name of a Named color, or the color 

model and color value. 

 

The Color Line. 
Current fill color and current line color blips are now shown on palette colors 

too. 
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Importing Named Colors 
When a design is imported into the current document (eg. import from the 

clipart gallery or import a XAR file) any Named colors in the imported design 

which have the same names as colors in the current design are given the color 

values from the current design. This means that you can choose a template, 

change its theme colors and then import more templates of the same theme and 

the imported designs will immediately pick up your modified theme colors. For 

example, import a red graphical button from the Clipart Gallery, change its main 

theme color from red to green, then import a red logo graphic of the same 

theme. When the logo appears in your design, instead of being red it will have 

picked up your chosen green theme color automatically. 

 

Colors in The Name Gallery 
The Used colors section of the Name Gallery lists the colors used by the 

current document (or by the current page of the current document in the case 

of multi-page documents). 

 

The Name Gallery now shows used palette colors and used edited colors as well 

as Named colors (earlier versions showed only Named colors). 
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Clipart Gallery - Import to New Page 

You can now right-click on a design in the Clipart Gallery and choose the new 

option "Import to new page". 

 

This imports the chosen design onto a new page of the current design. The new 

page is added following the currently selected page. 

 

New Pop-up Sliders 

The pop-up slider (for example as used for the feather control) has been 

improved so that it now works in two different ways. As in earlier versions you 

can still click, drag and release all in one mouse operation and the slider then 

disappears immediately. However now alternatively you can click and release the 

button to make the slider appear, then click and drag on the slider as many times 

as required, and then click away from the slider to make it disappear. This 

updated slider is also used extensively in the new photo tool.  You can also use 

the mouse wheel over the slider to adjust the values by +/- one unit. 
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Quality Slider (new "very high" quality setting) 

The quality slider, which allows the user to choose how their design should be 

displayed, has been simplified. There are now fewer quality steps, making it 

easier to use. However there is also now a new "Very High Quality" setting, 

which makes photos that have been scaled down appear at much higher quality 

than before. 

 

There are 5 different quality settings, which are as follows: 

• Outline only. This is now fully anti-aliased for higher quality screen display 

• Outline with blend steps 

• Full color (no anti-aliasing) 

• High Quality (full anti-aliasing. Image smoothing)  

• Very high quality (industry best anti-aliasing. New bi-cubic photo display 

considerably improves the quality of scaled down photos). 

 

The default quality level is "High" to give the most useful balance between quality 

and performance. 

 

 

Import/Export Format Changes 

RAW Photo Import 
You can now import (either using the Import menu option or just drag n drop 

the file onto the Xtreme window) RAW digital camera files.  

  

The following other new formats have been added:- 

 

Import:- 

.JP2, .JPX, .J2C, .J2K, .JPF 

.DCM Digital Imaging and Communications in Medicine (DICOM) image format 

.FAX Fax image from a fax received or created with fax software 

.SGI Silicon Graphics Image 
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.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format 

used by mobile devices. 

  

Export:- 

.JP2, .JPX, .J2C, .J2K, .JPF 

.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format 

used by mobile devices. 

 

 

PDF Export 

When exporting PDF/X with font embedding turned on, all fonts are embedded. 

However when exporting PDF the 14 base fonts are not embedded, as these 

fonts are generally available to all PDF readers. 

 

Note: If fonts referenced by the document are missing, PDF export no longer 

issues a warning. Instead the substitute font chosen by Xtreme is used, with no 

warnings. The font warning dialog has been modified accordingly since it now 

reports only copyright restricted fonts which don't permit embedding. 
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Templates 

A large collection of new top quality editable templates have been added, 

including more brochures / flyers, newsletters and new categories such as web 

pages and scrapbooking. You can find them in the Clipart Gallery. 

 

Selector Tool  

In the Selector tool, when dragging to select objects, the objects are now shown 

as selected during the drag and not only when the drag is complete.  

 

Marquee selection options 

By default, dragging a selection rectangle selects only those objects which are 

wholly inside the rectangle. This behavior can be changed so it's compatible with 

the way selection works in Adobe applications, whereby the objects touching 

the rectangle outline also become selected. Hold down the Ctrl key while 

dragging, to include in the selection those objects touching the selection 

rectangle. The Utilities > Options dialog enables you to change this default 

setting for marquee selection. So you can choose to have objects touching the 

selection rectangle selected, without having to hold down the Ctrl key during 

the drag. In this case, holding the Ctrl key down while dragging selects only the 

objects wholly inside the rectangle. 
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Other Miscellaneous Changes 

• Improved, more accurate shape intersection (path clipping) 

• Zoom out now retains the image in the center of the screen even down 

to small zoom  

• Single tile bitmap fills now show transparent around the outside, in order 

to avoid edge aliasing effects (and it's also more compatible with Adobe 

clip regions).  

• Outline mode is now anti-aliased, for a much higher quality display 

• Right  click copy / paste text when in the Text tool 

Flash export is now automatically clipped to page size.  


